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Important Notice 

COPYRIGHT 
The material in this document is copyright to Fairlight.AU Pty Ltd, and may not be quoted 
or reproduced in any form without written permission from the company. 

Fairlight is a trademark of Fairlight.AU Pty Ltd. All other trademarks are the property of 
their respective owners. 

LIMITED WARRANTY POLICY 
All the software and hardware provided with, or purchased especially for, Fairlight 
products has been tested for functionality. Fairlight.AU Pty Ltd will make its best efforts 
to correct reported defects for future releases subject to technical practicalities. 
Fairlight.AU will also replace any defective media on which software has been delivered 
provided that the item to be replaced is returned to the dealer who supported the 
product within 90 days of purchase. 

Fairlight.AU Pty Ltd makes no warranty or representation either expressed or implied 
with respect to the system's performance or fitness for a particular purpose. 

In no event will Fairlight.AU Pty Ltd be liable for direct or indirect damages arising from 
any defect in the product or its documentation. Further, Fairlight.AU Pty Ltd will not 
accept any liability for any programs, sounds, audio recording or sequences stored in or 
used with Fairlight products, including the cost of recovery of such data. 

Product features and specifications are subject to change without notice. Fairlight.AU re-
serves the right to change any part of this document without notice. 

The warranties, remedies and disclaimers above are exclusive and take precedence over 
all others, oral or written, express or implied, to the extent permitted by law in the 
geographical area of the product's use. No employee of Fairlight.AU, agent, distributor or 
employee of an agent or distributor is authorized to offer any variation from this policy. 

Copyright © 2007 
Fairlight.AU Pty Ltd, 
Unit 3, 15 Rodborough Rd, 
Frenchs Forest, NSW 2086, 
AUSTRALIA. 
Telephone +61 2 9975 1777 
Fax +61 2 9975 1999 

END USER LICENSE AGREEMENT 
You have acquired a device (“DEVICE”) which includes software licensed by Fairlight.AU 
from one or more software licensors (“Fairlight.AU's Software Suppliers”). Such software 
products, as well as associated media, printed materials, and “online” or electronic 
documentation (“SOFTWARE”) are protected by international intellectual property laws 
and treaties. The SOFTWARE is licensed, not sold. All rights reserved. 

IF YOU DO NOT AGREE TO THIS END USER LICENSE AGREEMENT (“EULA”), DO NOT 
USE THE DEVICE OR COPY THE SOFTWARE. INSTEAD, PROMPTLY CONTACT 
Fairlight.AU FOR INSTRUCTIONS ON RETURN OF THE UNUSED DEVICE(S) FOR A 
REFUND. ANY USE OF THE SOFTWARE, INCLUDING BUT NOT LIMITED TO USE ON THE 
DEVICE, WILL CONSTITUTE YOUR AGREEMENT TO THIS EULA (OR RATIFICATION OF 
ANY PREVIOUS CONSENT). 

GRANT OF SOFTWARE LICENSE. This EULA grants you the following license: 



   

• You may use the SOFTWARE only on the DEVICE. 

• NOT FAULT TOLERANT. THE SOFTWARE IS NOT FAULT TOLERANT. Fairlight.AU 
HAS INDEPENDENTLY DETERMINED HOW TO USE THE SOFTWARE IN THE 
DEVICE, AND Fairlight.AU'S SOFTWARE SUPPLIERS HAVE RELIED UPON 
Fairlight.AU TO CONDUCT SUFFICIENT TESTING TO DETERMINE THAT THE 
SOFTWARE IS SUITABLE FOR SUCH USE. 

• NO WARRANTIES FOR THE SOFTWARE. THE SOFTWARE is provided “AS IS” and 
with all faults. THE ENTIRE RISK AS TO SATISFACTORY QUALITY, 
PERFORMANCE, ACCURACY, AND EFFORT (INCLUDING LACK OF NEGLIGENCE) 
IS WITH YOU. ALSO, THERE IS NO WARRANTY AGAINST INTERFERENCE WITH 
YOUR ENJOYMENT OF THE SOFTWARE OR AGAINST INFRINGEMENT.   IF   YOU   
HAVE   RECEIVED   ANY   WARRANTIES   REGARDING   THE   DEVICE OR   THE   
SOFTWARE,   THOSE WARRANTIES DO NOT ORIGINATE FROM, AND ARE NOT 
BINDING ON, Fairlight.AU'S SOFTWARE SUPPLIERS. 

• Note on Java Support. The SOFTWARE may contain support for programs written 
in Java. Java technology is not fault tolerant and is not designed, manufactured, 
or intended for use or resale as online control equipment in hazardous 
environments requiring fail-safe performance, such as in the operation of nuclear 
facilities, aircraft navigation or communication systems, air traffic control, direct 
life support machines, or weapons systems, in which the failure of Java 
technology could lead directly to death, personal injury, or severe physical or 
environmental damage. Sun Microsystems, Inc. has contractually obligated 
Fairlight.AU's Software Suppliers to make this disclaimer. 

• No Liability for Certain Damages. EXCEPT AS PROHIBITED BY LAW, Fairlight.AU'S 
SOFTWARE SUPPLIERS SHALL HAVE NO LIABILITY FOR ANY INDIRECT, 
SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES ARISING FROM OR IN   
CONNECTION WITH THE USE OR PERFORMANCE OF THE SOFTWARE. THIS 
LIMITATION SHALL APPLY EVEN IF ANY REMEDY FAILS OF ITS ESSENTIAL 
PURPOSE. IN NO EVENT SHALL Fairlight.AU'S SOFTWARE SUPPLIERS BE LIABLE 
FOR ANY AMOUNT IN EXCESS OF U.S. TWO HUNDRED FIFTY DOLLARS 
(U.S.$250.00). 

• Limitations on Reverse Engineering, Decompilation, and Disassembly. You may 
not reverse engineer, decompile, or disassemble the SOFTWARE, except and 
only to the extent that such activity is expressly permitted by applicable law 
notwithstanding this limitation. 

• SOFTWARE TRANSFER ALLOWED BUT WITH RESTRICTIONS. You may 
permanently transfer rights under this EULA only as part of a permanent sale or 
transfer of the Device, and only if the recipient agrees to this EULA. If the 
SOFTWARE is an upgrade, any transfer must also include all prior versions of the 
SOFTWARE. 

Obtaining Technical Support 
Users requiring technical support should contact their local distributor.  

Information can also be found on the world wide web at: 

http://www.fairlightau.com 



   

Manual Errors and Omission 
 
To help ensure that Fairlight provides the most accurate and comprehensive 
documentation, please report any errors or omissions to: 

documentation@fairlightau.com
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Chapter 1 -  Introduction 
Introduction  

Satellite-AV is part of a new family of products from Fairlight which marries together CC-1 
processing with an ergonomic physical control surface in a combination that has a significant 
impact on productivity and efficiency. 

The Satellite-AV interface incorporates a unique dedicated editing console and an advanced 
graphical user interface for mixing, plus powerful database capabilities. These tools allow the op-
erator to work quickly and efficiently without impeding the creativity of the digital recording, 
editing and mixing process. 

About This Manual 
The Satellite-AV User Manual provides all the information necessary to rapidly become proficient 
at operating the system in a professional audio environment. 

This manual is designed to familiarize sound editors and engineers with the facilities provided by 
Satellite-AV. The terminology and concepts used in this manual assume a reasonable knowledge 
of audio principles and studio procedures. 

Finding the Information You Need 
Read through the chapters in the order presented to learn all the features of the system or use 
the Table of Contents or Index to quickly find the specific information you require. The manual is 
divided into the following chapters, each covering a specific topic: 

Operational Instructions 
Chapters 2 to 35 describe the procedures used to manage workflow and perform recording, 
editing, signal processing, playback and mixing operations. 

Installation Instructions 
Complete installation instructions are included in the DREAM II Installation Manual. 

Specifications 

Chapter 36 includes complete specifications and connection details for the Satellite-AV System. 
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Chapter 2 -  Satel l i te-AV Overview 

Introduction 
Satellite-AV is the latest generation digital audio system from Fairlight, offering exceptional power 
and speed for recording, editing and mixing. 

Configurable with up to 96 disk recorder tracks and up 212 physical inputs and outputs, Satellite-
AV integrates full recording and editing capability with a fully featured, fully automated mixing 
engine capable of delivering final mixes in any format up to 7.1 surround. 

A highly intuitive work surface enables fast, ergonomic access to all of Satellite-AV’s  many 
features. These include 8-band EQ, three-stage dynamics processing, and comprehensive 
grouping of faders and buses. Satellite-AV is also equipped with Fairlight's well-known Binnacle 
editor. The Binnacle presents the key editing functions in a highly optimised layout centred 
around the jog wheel. A new set of mouse-based editing functions adds even more convenience 
and familiarity to Dream II’s editing interface. 

While Satellite-AV is a complete solution for a studio undertaking full production and mixing of 
the majority of long form, commercials, film and radio work, it is also part of the Dream II Family 
of products and is the ideal partner to Constellation-XT, a full-featured mixing system, and 
Station, an integrated editor and mixer. 

Terminology 
Mixing Section The portion of the Satellite-AV control surface that provides 

mixing control. 

Editing Section The portion of the Satellite-AV control surface that provides 
editing control. 

Project The file created by Fairlight software containing the stored 
audio and its editing and mixing instructions. 

Physical 
Input/Output 

An analog or digital audio input or output. 

Track Feed A signal path (channel) feeding to or from the disk recorder 
which can be processed and routed to mix buses and 
monitoring. 

Live Feed A signal path (channel) fed from a live, real time signal that 
has been brought from a physical input and can be 
processed and routed to mix buses and monitoring. 
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Bus Destination of a mixing operation. Feeds are usually routed 
to buses via a multiformat surround panner. Buses may be 
configured with various multichannel formats such as stereo, 
LCRS, 5.1 or 7.1. Multitrack buses provide bus paths for 
summing feeds to be recorded to disk or other I/O. 

Bus Element One component signal of a bus (e.g. left, right, centre or 
surround). Bus elements are automatically allocated to 
individual buses as they are created. Each system has a 
finite number of bus elements which will limit the format of 
buses as they are created. For example, a Mocha Espresso 
sized Satellite-AV has 48 available bus elements allowing: 1 
X 5.1 main bus, 4 x 5.1 sub-buses, 2 X 5.1 auxes, and 2 X 
stereo auxes; or, 1 X 7.1 main bus, 3 X 5.1-buses, 4 X 
stereo aux buses, and 4 X mono aux buses and 8 X 
Multitrack buses. On the other hand a Grande Latte size has 
72 available bus elements. 

Signal Flow 
Signal paths for feeds and buses comprise both fixed and moveable processing blocks. Signal 
paths may be configured in formats from mono up to 7.1 surround. Individual elements may be 
controlled together as part of a bus or Link Group, or unfolded and controlled separately. When a 
track feed is armed for recording, the fader may be switched to control the level at the input to 
the disk recorder as shown below. 

Track and Live Feeds 
• Up to 96 Track Feeds 

• Up to 48 Live Feeds 

• 4 band automated EQ: Bell, Shelf - High & Low, Notch 

• 2 band automated Filters: High Pass and Low Pass at 12 pr 24 dB per octave 

• Compressor plus Limiter plus Expander / Gate 

• Insert 

• Direct Out 

• Track Metering 

• Aux Sends: 12, each in any bus format up to 7.1 

• Fader and Mute 

• Panning: up to 7.1 surround 

Link Groups 

• Up to 8 members with linked parameter controls and support for advanced surround 
panning features. 
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Main Bus 
• 1 x Main Bus 

• Formats: Mono, Stereo, LCR, LCRS, LCRSS, 5.1, 6.1, 7.1 

• Compressor  

• Insert 

• Direct Out 

• Master Fader and Mute 

Sub-Buses 
• 8 x Sub-Buses 

• Formats: Mono, Stereo, LCR, LCRS, LCRSS, 5.1, 6.1, 7.1 

• Compressor  

• Insert 

• Direct Out 

• Master Fader and Mute 

Aux Buses 
• 12 x Aux Buses 

• Formats: Mono or Stereo, LCR, LCRS, LCRSS, 5.1, 6.1, 7.1 

• Insert 

• Master Fader and Mute 

Multi Track Buses 
• 24 x Multi - Track Buses  

• Mono Format 

• Master Fader and Mute 

User Interface 
The Satellite-AV system offers improved ease of use and operator efficiency, achieved through 
integration and advanced ergonomic design of the user interface. 

Satellite-AV is made up of five interconnected hardware devices: 

1. PC containing CC-1 Engine 

2. Audio Interface box(es) (one SX-20 and optional SX-48s) 

3. Satellite-AV console with Mouse 

4. Recorder/Editor Video Monitor (not supplied) 
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5. Mixer Video Monitor (not supplied) 

Plus additional optional components: 

• Main Meter 

• Channel Meters 

• MADI interface cards 

“Selection” and “Calling” 
Because Satellite-AV supports various recording, editing and mixing functions, it is useful to refer 
separately to the way channels are singled out for different functions. 

Selection 

“Selection” is used when a signal path is to be acted upon by the Editing, Patching or Automation 
software. 

In Editing, Patching and Automation operations, selection is done using the Selection Panel or the 
Mouse. 

Calling 

“Calling” is used when a signal path is to be brought to the Fat Channel, where the mixer is 
controlling a single channel in real time. 

Calling a channel is done by pressing the CALL button on any fader, or by mouse-clicking a signal 
path on the Mix Display. 

There is also a Call mode where automatic calling features can be set up. 

Satellite-AV Features 
The Satellite-AV control surface incorporates the various hardware user interface features 
indicated below: 
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Track Selection Keys 

The Track Selection Keys are used for selecting tracks and clips for editing and for arming tracks. 
Press a track key to add a track to the current selection. Double press a key to select that track 
only. To select a range, hold down the first key and double press the last track in the range. 

The Track/Channel Selection Keys are also used to select analog I/Os and signal paths for 
patching. 

The second and third banks of tracks, numbers 33 to 64 and 65 to 96, are selected using the 
Track Bank key. 

A track can also be selected or deselected by clicking its number in the left column of the screen 
with the mouse. Double-clicking a track’s number makes it the only selected track. 

Menu Keys 

These menu keys provide access to a range of editing, project management and signal 
processing functions. Many keys have two functions the names of which are displayed in colour 
on the button cap. To activate the function displayed in blue, press and hold one of the BLUE 
keys while pressing the menu key. 

Most functions can also be selected from the screen using the standard Windows menu system. 

Track Keys 

Menu Keys Menu Keys 

Macro Keys 

Numeric and 
Track View 
Keys

Transport 
Keys 

LCD and 
Soft Keys 

Edit Option 
Keys 

Binnacle 
and Jogger 

Edit Target 
Keys 
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Soft Keys 

Soft keys provide access to the menu options displayed on the LCD display. There are two rows 
of soft keys, upper and lower. The soft keys are illuminated to show available menu options, and 
flash when an operator response is required. 

LCD Menu Display 

The LCD display provides status information and displays the menu options associated with the 
Menu Soft Keys. Menu options are displayed immediately above or below the Soft Key used to 
select the option. 

Project and Machine Control Keys 

These Menu Keys provide access to the main project navigation functions, machine control, and 
autolocation menus. To activate the function displayed in blue, press and hold one of the three 
BLUE keys while pressing the menu key. 

Edit Target Keys 

These keys modify the effect of each edit. For instance a Cut may be performed on a Range, a 
Clip, the Head of a clip or the Tail of a clip. 

Transport Keys 

The transport keys provide standard tape transport functions plus Jog/Shuttle selection and a 
range of play options under the Play Menu. To enter Record press the Play and Record keys 
together. Hold down the Jog/Shuttle key for a menu of Jog/Shuttle settings. Hold down the 
Record key for a menu of record options. 

The QWERTY keyboard space bar can also be used to Play and Stop the transport, provided that 
the Editing screen has focus (click anywhere on that screen to give it focus). 

Macro Keys 

Macro keys can be programmed to play back sequences of keystrokes. There are three banks of 
nine macro keys. 

Binnacle Editing Keys and Jog Wheel 

The Binnacle is at the heart of Satellite-AV ’s advanced editing interface. Dedicated edit functions 
are associated with these keys. In addition to normal Jog/Shuttle transport operations, the jog 
wheel is used for zooming and parameter selection in soft menus. 

Numeric and Track View Keys 

The Numeric Keys are provided for entering timecode locations or parameter values. By pressing 
and holding one of the three BLUE keys, the Track View Keys select the number of tracks visible 
on the monitor track display. The Clear key can be used to clear numeric and text fields on the 
LCD menu and also to cancel dialogue box requests. 

Edit Option Keys 

The edit option keys modify the effect of each edit. An edit can be performed on All Layers, on 
a time Range, and can insert or delete time via Razor mode. 
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Mouse 

The mouse (or trackball) is used as a conventional pointing device for the on-screen graphical 
interface. 

Many new mouse-based functions have been added to the user interface in Satellite-AV. All 
mouse-based functions will be described in context of their appropriate editing chapters. 

Recorder/Editor Display Features 
The graphical display provides status information, clip and waveform display and visual feedback 
for editing functions. 

 

Smart Pane 

This area contains a number of different displays at different times. It may show Meters, Clip EQ 
parameters, Fade parameters, and so on. Each description of editing functions will include details 
of the Smart Pane display elements. 

Smart Pane 

Range 
display 

Track and 
clip area 

Track 
Selection 
Panel 

Timecode 
display 

Status View 
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Range Display 

This area contains three timecode values associated with Editing Ranges. They are, respectively, 
the Range In time, Range Out time, and Range duration. When Range is switched off, these 
numbers show the last range that was created, which can be restored by pressing the Range On 
key, or selecting the Range On command from the Edit Menu. 

Track and Clip Area 

This area shows a selection of the available tracks, and the audio clips on them. A complete 
description of all its functions is contained in the chapter on Editing. 

Timecode Display 

This line shows the timecode at the left and right of the screen, and also at the centre line (or 
Play Cursor position). 

To the right of the timecode display are two lights which change colour as follows: 

Sync – shows green if the system has a viable sync signal, otherwise red 

Position – shows green if the system sees a viable position signal, such as timecode or 9-pin, 
otherwise red. 

Status View 

This area shows information such as the Project name, and status and alert messages from the 
system.  

Mixer Display Features 
The mixer display shows real-time status of fader levels for all track feeds, live feeds and buses, 
plus signal levels for the Main bus and the currently called signal path. Also shown is the path 
configuration for the current path displaying the status of all signal processing parameters. A 
path may be a single mono feed or a bus or multichannel surround format link group. 

• Faders can be clicked and dragged with the mouse to change level. 

• Faders can be double-clicked to set them to 0 dB. 
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Track Feed and Live Feed Channel Tiles 

Each Track and Live Feed is represented with the track name and fader level, plus indicators for 
EQ, dynamics, insert, solo, solo defeat, and mute. 

The parameter window within each channel tile provides a condensed display of the current 
settings of the Channel Panel for EQ, dynamics or pan. 

• EQ – a graph displays the EQ transfer response. 
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• Dynamics - a transfer function for compressor, limiter, expander, gate, and the various 
combinations of these can be displayed. 

• Pan - a miniature display of the pan surround field with the red pan position is displayed. 
The pan position changes in real time. 

To select the type of display, click in the parameter window. It will cycle amongst the three 
types. 

Buses 

The fader levels of the Main, sub and auxiliary buses are displayed. Signal level meters for the 
Main bus are also displayed. 

Signal Path Display 

The signal path display, or Fat Channel, shows a detailed display of the parameters for the 
currently called signal path. A signal path may be a mono live or track feed, a bus or a 
multichannel surround format link group which can be selected and modified from a single set of 
controls. 

• The user and system names of the signal path are displayed at the top left. The input 
box at the left of the signal path, indicates the format or element name of the path and 
the user name and system name of the physical input from which it is patched 

• The input meter shows the signal level at the input of the signal path.  

• If a track feed is selected, the input fader level is shown.  

• The EQ display shows a graph of the equaliser response. The numeric values of the 
parameters currently being modified are displayed below the graph. If the equaliser is 
switched IN the graph is highlighted, if switched OUT the graph is dimmed. 

• The dynamics display shows the composite transfer function of the entire dynamics 
section. The display also includes gain reduction signal meters for all three sections. The 
numeric values of the parameters currently being modified are displayed below the 
graph. If the dynamics are switched IN the graph is highlighted, if switched OUT the 
graph is dimmed. 

• The insert send and receive I/O patching is displayed. If the insert is switched IN the 
insert display is highlighted, if switched OUT the display is dimmed. 

• The main fader level for the signal path is displayed with a numeric display of the fader 
gain. 



Operator Reference Manual  CHAPTER 2 - SATELLITE-AV OVERVIEW April 5, 2007 
   

Satellite-AV Page 22 

• The direct out level, pre/post status and output patching is displayed. If the direct out is 
switched ON the direct out display is highlighted, if switched OFF the display is dimmed. 
The direct out level is shown with a horizontal bar. If the direct out is switched ON the 
bar is yellow, if switched OFF the bar is violet. The section of the bar above 0dB of gain 
is shown in red. 

• The Auxiliary bus display shows the status of each aux send. The send level is shown 
with a horizontal bar. If the send is switched ON the bar is yellow, if switched OFF the 
bar is violet. The section of the bar above 0dB of gain is shown in red. 

• The pan display offers a sophisticated representation of the signal path panner. The 
display always shows a 7.1 sound field as the panning information for any path can be 
applied to any format bus to which it is assigned. The red circle indicates the current pan 
position. The white brackets show the current position of the joystick which must be 
moved over the red circle to capture control of the pan position. If a link group has be 
called, the pan display shows a red circle for the pan position of each member and a 
yellow circle for the position of the virtual link group master. When diverge is applied, a 
white circle represents the perceived image size. 

• When a bus is called, the output box displays the output patching, showing each bus 
element and the user and system names of the physical outputs to which they are 
connected.  

Starting the System 
Step 1 Start the host computer (PC) by turning on its power switch. The PC will boot the 

Windows XP operating system and display your PC desktop. Both video monitors should 
be powered up and displaying the Windows desktop. 

Step 2 Power on the audio interface box(es) (SX-20 and optional SX-48s). In most installations 
they can be left powered on all the time, and will “wake up” when the PC starts up and 
the CC-1 board initialises. 

Step 3 Power on the Satellite-AV mixer surface. 

Step 4 Start the Dream II application by double-clicking its desktop icon, or by selecting it in the 
Start Menu under the Fairlight group. 
If the system is correctly configured, the FMC mixer application will also start 
automatically with Dream II. 

System Shutdown 
Step 1 Exit Dream II by selecting Exit from the File Menu, or by the keystroke combination Alt-

F4 when Dream II is in focus (click anywhere on the editing screen to bring it into focus 
if necessary). 

Step 2 If a project is open, the system will prompt you to save any changes that have occurred 
since it was opened. 
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Click Yes if you want to save the changes in the project. This may take a minute or so, 
during which a progress bar will grow in size. 

Step 3 You may now power down the Satellite-AV surface, and shut down your PC if desired. It 
is recommended that the audio interface boxes remain powered up unless you are 
dismantling the installation. 

Using the System 
Follow the instructions in the following chapters to quickly learn all the operating procedures 
necessary for completing audio production tasks with Satellite-AV.
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Chapter 3 -  Projects 

Introduction 
DREAM II uses ‘Project’ files to store your work. All audio recordings, editing and file imports are 
done within Projects. A project contains all the edit information, mixing, patching and automation 
data, plus DREAM II settings, as well as links to the audio and/or video files that have been 
incorporated into the project. Edits performed on the audio and video data are non-destructive 
and are represented by clips which refer to pieces of audio or video data. 

As with other standard Windows applications, Projects must be saved to disk before being closed, 
or all changes since opening will be lost. Project files are given the .MT filename extension by 
default. 

Opening a Project 

Step 1 Select the Open command from the onscreen File Menu in the Editing screen. 
Alternatively you may press the Proj button in the DREAM II console, then click the 
{open} soft key from the drop down menu in the Editing screen. 

Step 2 The system displays a list of all the projects in the last folder you visited. If necessary, 
browse to other folders to see other projects that you may wish to open. 

 

Step 3 Click on the name of the Project you wish to open, then click the Open button. The 
system will load all of the audio and reconnect to external files that were used last time 
in the project. 
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Opening a Recent Project 

DREAM II keeps a list of your most recent projects. To open one of these, click the File button, or 
press the Proj key, to display the File Menu. 

Your four most recent projects are shown at the bottom of the menu list. Simply click on one of 
them to open it again. 

Opening Files Across the Network  

If your DREAM II system is part of a PC network, the system will allow you to open a Project 
located across that network, for example on a server. In this situation the number of tracks that 
can be played may be limited, depending on network bandwidth and other traffic. In addition, 
the response of the system may be slower than usual. 

For best performance, it is always best to locate projects on the local hard drive in your DREAM 
II PC. 

Creating a New Project 

Step 1 Select the New command from the File Menu in the Editing screen. Alternatively you may 
press the Proj button in the DREAM II console, then click the New command from the 
drop down menu in the Editing screen. 

Step 2 The system displays the New Project dialog. 

 

 Step 3 Fill in the form presented by the system. 

Project Name The name you enter here cannot be changed before saving the file, though it 
is possible to Save As under a different name. It is also possible to rename the 
project, as explained below. 

Comment Put any text in here for your convenience. 

Sample rate The system supports sample rates up to 96 kHz. The number you enter here 
can be changed in the Sync display up to the time of your first recording, but 
after that it is fixed for subsequent recordings. 
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Frame The value you place here can be changed in the Sync display at any time 
afterwards. It should match the incoming timecode format for correct 
synchronisation. 

Sample Type The system supports sample depths of 16 or 24 bits. You can change this 
value at any time, affecting subsequent recordings. All previously recorded 
audio is played back at its recorded sample depth. 

Video Add Video Track. If this is checked the system will display a video track at the 
top of the track display. 

Audio Tracks Choose the number of tracks you would like in the project. 

 Step 3 Click OK to create the project. 

Closing a Project 
There is no explicit Close command. You may load or create a new project at any time, or shut 
down the system. Instructions for shutting down the system can be found in the section System 
Shutdown in Chapter 2. 

Note that, when opening or creating a new project, the system will prompt you to save the one 
that is already open (if any). This must be done for your recent changes to be saved. 

Deleting Projects 
A project can be deleted using Windows Explorer, like any other file. It is also possible to delete a 
file in the Open or Save dialogs, as follows: 

Step 1 Select the Open or Save As command from the File Menu in the Editing screen. 

Step 2 The system displays the appropriate dialog. 
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Step 3 Right-click on the file you wish to delete. The system will display a list of commands. 

Step 4 Select delete from the list of commands. The system will ask you to confirm that you 
wish to delete the file. 

Renaming Projects 
A project can be renamed using Windows Explorer, like any other file. It is also possible to delete 
a file in the Open or Save dialogs, as follows: 

Step 1 Select the Open or Save As command from the File Menu in the Editing screen. 

Step 2 The system displays the appropriate dialog. 
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Step 3 Right-click on the file you wish to rename. The system will display a list of commands. 

Step 4 Select rename from the list of commands. The system will highlight the current name of 
the file, allowing you to edit it. Press the ENTER key after editing, to confirm your new 
name for the project. 
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Chapter 4 -  Tracks & Transport 

Introduction 
DREAM II provides up to 192 disk recorder tracks routed via dedicated track feeds. In addition 
to the track feeds DREAM II supports 96 live feeds which may be used for effects returns or any 
other real-time signal source. DREAM II supports up to 256 analog and digital inputs and 
outputs which may be patched to track feeds or buses as required (see “Patching and 
Assignments” on page 38 for more details on patching). 

Displaying Tracks 

Number of Tracks 
Disk recorder tracks are displayed on the video screen. Select the number of tracks to display 
by holding down the BLUE key, and pressing one of the numeric keys labeled 1T, 2T, 4T, 8T, 
16T, 24T, 32T and 48T. The most recently selected track always appears in the track display. 

Step 1 Hold down the BLUE key 

Step 2 Press the desired Track Display key 

You can also select the desired track view in the onscreen View Menu, Tracks Submenu. 

 

User Selection of Tracks 
In addition to the track selections described above, you can display any number and selection of 
tracks, including discontiguous numbers. There are three User Sets, labelled U1, U2 and U3, 
which can be set and recalled at any time. 

To create a User Set 

Step 1 Hold down the BLUE key 

Step 2 Press the 3, 6 or 9 key, and hold it down. 
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Step 3 Select the tracks that you want in this set. Deselect tracks that you do not want in this 
set. 

Step 4 Release the 3, 6 or 9 key. 

To access a User Set 

Step 1 Hold down the BLUE key 

Step 2 Press and release the 3, 6 or 9 key. 

To return to a contiguous track set, simply select one. 

NOTE: When a user set is displayed, the last-selected track does not automatically appear on 
screen. 

The Clip 
When audio is recorded or imported into Satellite-AV it is displayed as a clip. The clip is a 
reference to the audio data stored on disk. Clips can be cut, copied or moved without affecting 
the original audio data. 

When new clips are recorded or pasted above existing clips, the clips become layered one 
above the other. Normally only the top clip is seen and heard during play-back. DREAM II now 
allows all layers to be seen and heard simultaneously. To do this, use the BLUE + Takes key to 
toggle Display layering on or off, or select/deselect Display Layering in the onscreen View 

menu. 

 

While Display Layering is on, you can drag clips from one layer to another using the mouse. 
This is described in more detail in Chapter 11 – Editing. 

The left end of the clip is known as the head. The right end is the tail.  

Clips also contain information about the original timecode location of the audio data when 
recorded, and the current timecode location of the displayed clip.  

If a clip shows only a portion of the associated audio data on disk, it may be trimmed to show 
more. 
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Multichannel Clips 
DREAM II adds the concept of ‘Multichannel Clips’. Currently Multichannel clips are limited to 
Stereo for legacy compatibility. Multichannel clips are displayed with a link (chain) icon. You can 
create multichannel clips in the onscreen Edit menu. Once a clip has been defined as 
multichannel, operations on one channel of the clip (eg –EQ) affect all other channels. 
Multichannel status can be toggled on or off, allowing for independent control of each clip 
channel. 

Selecting Tracks 
The Satellite-AV Selection Panel has 32 dedicated Track Feed selection keys.  

The feed selection keys perform different functions depending on the current mode of 
operation. The selection keys are used for selecting tracks for editing or mixing, creating 
groups, arming tracks and enabling automation. 

Feeds may be grouped and linked in various formats. Selecting the Group Master or a member 
of a Link Group will select all members of the group. See “Grouping” on page 85 for more 
details on group behaviour. 

In FOLLOW mode, the master fader selection follows the most recent edit track selection. 
FOLLOW is selected from the CALL menu by pressing the Call key.  

In the edit modes, selected tracks are highlighted on the video display and the track keys are 
illuminated. 
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Using Track Keys 
Press a dark track selection key to add that track to the selection. 

Press a lit track selection to remove that track from the selection. 

To select a range of tracks, press and hold down the first track select key and double click the 
last track selection key you wish to be active. All other selections will be deselected. 

To select a single track, double click on the desired track selection key. All other selections will 
be deselected. 

Selecting a track which is a member of a link group will select all tracks in the link group. To 
select an individual member of a link group, hold down the BLUE key and press the track 
selection key. 

The track selection may also be changed by holding the Track Sel key, to the left of the jog 
wheel, and turning the jog wheel or pressing the + or - keys. This is useful for moving 
selections from one track to another. 

The most recently selected track is always displayed. 

 

TRACK BANK Key 

The TRACK BANK key is used to switch between three banks of 32 tracks, making up the 
maximum total of 96. It affects both the track selection keys and the tracks displayed on the 
Edit Screen. 

To use it, hold down the TRACK BANK key, then press one of the LCD Soft Keys. 

Using the Mouse 
Press a dark onscreen track selection key to add that track to the selection. 

Press a lit onscreen track selection to remove that track from the selection. 

Click and drag your mouse in the onscreen track selection pane to select/deselect multiple 
tracks. 
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To select a single track, double click its number. All other tracks will be deselected. 

Another way of selecting a track is to ctrl-click on a clip. This cannot be used to deselect a 
track. Ctrl-clicking will also select the clip, and create a range (or extend the current one) to 
include that clip. 

Note: the mouse can also be used to: 

• Mute or unmute a track – click the M 

• Solo or unsolo a track – click the S 

• Arm or disarm a track – click the button at left (the track must have an input patched to 
it, before it can be armed) 

Click here to deselect 
Track 4 

Click here to 
select Track 9 
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Time Scale and Display Zooming 
The track display represents a 24 hour continuous loop. The timescale can be zoomed from 
about two frames wide to eight hours wide.  

At all times, the cursor position indicates the current play point. 

Step 1 Hold down the Zoom Binnacle key 

Step 2 Turn the jogger wheel to zoom in and out 

The Mouse wheel can also be used to zoom the display. 

Sub-frames can be toggled on or off by holding down the BLUE key and pressing the SUBF key 
on the numeric keypad. 

Track display selection and zooming is possible while playing and recording. 

Transport Controls 
The PLAY, STOP, FF and REW controls work in a similar manner to a tape machine. An 
additional feature is increasing the fast-forward and rewind speeds by pressing the respective 
keys multiple times. This accelerates through 8, 24, 60, 150 and 360 times play speed. 

To enter record press the REC and PLAY keys together. 

 

The play command can be accessed also by pressing the PLAY key on the Binnacle. See 
“Editing” on page 61 for more details. 

The Space bar on the QWERTY keyboard can also be used to toggle the transport between Play 
and Stop, while the Track Display is in focus (click anywhere on the Track display to give it 
focus.) 

More Jog Commands 
Pressing the JOG key when stopped enters the Jog mode. 

Jog mode can also be accessed by pressing the Play/Jog key on the Binnacle. 

Holding the BLUE key while jogging increases the jog speed by four times. 

Mouse “Jogging” 
The mouse can also be used to move the transport. Simply right-click anywhere and drag 
horizontally to move the transport. Audio is not heard while this takes place. 

Shuttle 
To shuttle the transport, hold down the BLUE key and press JOG/SHUT. The jogger wheel will 
then increase and decrease the transport velocity in forward and reverse.  

Press the FF or REW keys to reverse the shuttle direction. To play at normal speed in reverse, 
press PLAY, hold down the BLUE key and press JOG/SHUT, then press REW. 

Jump 
The Jump keys provide a fast method of locating forwards and backwards through a Project. 

The Jump keys are located on the Binnacle, left and right of the Play/Jog key.  
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Jump Methods 
Holding down one of the Jump keys displays the Jump menu in the lower Satellite-AV display. 
POINT  The transport will locate to the head, tail, sync point or fade 

point(s) of a clip on the selected track or tracks.  

MARK The transport will locate to the next mark. 

Selecting one or both of these menu items will take effect when the Jump key is released, and 
will remain as the jump method until a different method is selected. 

If both Point and Mark are selected, the transport will stop at all the places mentioned above. 

NOTES: 

1. The sync point of a clip defaults to the head of a clip unless changed with the Edit 
menu, using the Set Sync Point command, or using the {sync point} soft key in the 
Binnacle Trim mode. 

2. Jump to point will only work on selected tracks. 

3. Holding down the Shift key and pressing a Jump key will override the Jump Menu and 
jump to point. Holding down the Ctrl key and pressing a Jump key will override the 
Jump Menu and jump to mark. 

4. Holding down the BLUE key and pressing either Jump key will locate the transport to 
the start or end of the Range. 

Keyboard Jumps 

Pressing the Left Arrow and Right Arrow keys on the QWERTY keyboard has the same effect as 
pressing the left and right Jump keys. 
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Locator functions 
Rapid navigation through the project is achieved by using the GO TO menu functions and by 
making MARKS on the time-line. For more information see “Go To” on page 129 and “Marks” on 
page 143. 

Selecting a Range 
A Range allows a group of clips across one (or multiple tracks) to be selected. Many functions 
provided by Satellite-AV require the use of a Range. Use the From and To keys on either side 
of the Jog wheel to set ranges. Range mode may be turned on or off by pressing the Range 
ON key, to the right of the Binnacle. 

Selecting a Range using Cursor Position 

Step 1 Locate to the time at which you wish to start the range. 

Step 2 Press the From key. (Some functions start with FROM automatically). 

Step 3 Locate to the time at which you wish to end the range. 

Step 4 Press the To key. 

The duration of the range is indicated on the screen time display above the track display, and 
the range is high-lighted on the track display. 

Many functions start making a range as soon as you enter the function. To change the FROM 
point, just press the From key at any time. 

Range Menu 
To access the Range menu options, press and hold either the From or To key and select the 
desired menu option by pressing the associated soft key.  

The following functions operate the same for both From and To: 
TIME  Enter a timecode value using the numeric keypad and press 

Enter. Alternatively, use the jog wheel or Jump keys to adjust 
the range independent of the play position. 

MARK  Select a mark by turning the Jog wheel and pressing Enter, or 
by pressing one of the flashing selection keys which represent 
previously entered marks. See “Marks” on page 123. 

PROJECT 
Begin/End 

Sets the FROM or TO points to the Project Head or Project Tail 
marks which mark the first and last positions at which audio 
has been recorded, or clips are placed.  

Jumping to Range ends 
Holding down the BLUE key and pressing either Jump key will locate the transport to the start 
or end of the Range. 

Setting a Range With the Mouse 

The mouse can be used to set a range. To do this, click in a part of a track where there is no 
clip, then drag the mouse to another timecode and release it. The time swept out by the mouse 
will become the new range. 

To remove a range, click where there is no clip, and the range will disappear. 
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Selecting Clips with the Mouse 

Clicking on a clip while holding down the Ctrl key on the  QWERTY or the BLUE key on the 
DREAM II controller keyboard causes the clip to be selected (or deselected if it was already 
selected). In addition, a range is created, exactly large enough to contain all clips that were 
already selected, plus the one just clicked. 

The newly created range does not, however, select any clips that were not previously selected, 
other than the one just clicked. Put more simply, Ctrl-clicking a clip adds to the selection 
without selecting any other clips. 

Similarly, a clip that was already selected can be deselected by Ctrl-clicking, as long as it is 
within a range. 

Combining the Mouse and DREAM II Controller 

It is often useful to combine the DREAM II controller and Mouse for fast, complex operations. 
For example, a range may be selected using the Transport Controls and From and To keys. 
Then individual clips within the selected range can be deselected using the mouse. 

Play Menu 
The Play Menu enables soft key selection of various transport selections. 

Step 1 Press the Play Menu transport key. 

Step 2 Press the desired soft key function. 

All the Play Menu functions except {again} preroll the transport by one second: 
head Plays from the head of the clip under the cursor on the last-

selected track (it has a blue name on the screen). If there is no 
clip under the cursor, the next clip to the right is played. 

tail Plays from the tail of the clip under the cursor on the last-
selected track (it has a blue name on the screen). If there is no 
clip under the cursor, the next clip to the right is played. 

fade Plays from the start of the fade-out on the clip under the cursor 
on the last-selected track (it has a blue name on the screen). If 
there is no clip under the cursor, the next clip to the right is 
played. 

again Plays from the same place the transport last went into play. No 
additional preroll is applied. 
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Chapter 5 -  Patching and Assignment 

Introduction 
Before any recording, editing or mixing can be performed on Satellite-AV, the system must be 
configured. 

Setting up Your Control Room Monitors 
If this is the first time your Satellite-AV has been used you will first need to set up and patch 
your control room monitors. See “Monitoring” on page 52 for instructions on patching and using 
your monitors with Satellite-AV. 

Some Terms 

Patching 
Patching means connecting signal paths – the output of one to the input of another. It can be 
accomplished as follows: 

• Use the Patch I/O screen if you are new to the system, don’t change patching very 
often, or don’t use the system very often. 

• Use the Selection Panel if you are an experienced user or plan to become one. It takes 
a little time to learn, but it’s faster for many operations. Note: it can only be used for 
patching Tracks, not Live Feeds or Buses. 

Assignment 
Assignment means sending signals to Buses, where they are collected and mixed. This is 
accomplished as follows: 

• Use the Assign menu to assign a lot of signals to one bus. 

• Use the Mixer screen Virtual channel display to see and change all the bus assignments 
for one feed. To see this display, right-click on a tile in the Mixer Screen. 

Patching Methods 
Satellite-AV offers several different patching methods, summarised in the following paragraphs. 
All methods can be used at the same time. 

Patching with the I/O screen  
In this method, signal paths and physical inputs are shown on the mixer screen, and can be 
selected by touch. It has the advantage that the signal path labels, such as “CD Left” or 
“Reverb Ret 2”, can be seen and readily chosen. It also provides exactly the same method for 
insert sends and returns as for other signal paths. 

NOTE: Most new users will find this patching method easier. 

Patching with the Selection Panel 
In this method, signal paths and physical inputs are selected on the Track Keys. It has the 
advantage of speed, particularly when patching groups of signal paths. 
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Only Tracks can be patched using this method. 

Using the Patch I/O Screen 
The following basic steps are used to patch any signal to any other. 

Step 1 Press the Patch I/O key. The system displays the Patch I/O screen. 

Step 2 Select a Source (see below). 

Step 3 Select a destination (see below) 

Step 4 Touch (or click) the Patch button on the screen. 

The Patch I/O Screen 
All patching operations are carried out on the Patch I/O screen, which is used to represent the 
physical inputs, outputs and signal paths being patched together. This is automatically shown 
when the Patch I/O button is pressed. You can force its display by typing <SHIFT-Pause|Break> 
and then P. You can make it go away by pressing the Patch I/O key again, or the Escape key. 

Sources are shown on the left of the screen, while destinations are shown at the right.  

 

Signal Path Categories 

Categories of signal paths are selected in the lower part of the screen. 

Source categories 

Sources 

Destination categories 

Command 
Buttons 

Destinations 
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Selecting a category of sources expands the category in the upper left of the screen. 

 

In this case the Rewire outputs have been selected. 

 

 

Source categories 

Destination categories 
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Selecting a category of destinations expands it into the upper right of the screen. 

 

In this case the analog outputs are shown. 

Making a Patch 

Select a source and a destination (e.g. Aux 1 C and Ana 3) then touch the Patch button in the 
center. 

 

Afterwards the tiles used in the patch will show the results. Source is always shown above 
destination. 

 

 

 

                     

Notes: 

You can select multiple sources and multiple destinations and patch them all with one 
command. For example, select Analog Inputs 1 to 8 and Track Inputs 9-16, then click the Patch 
command once. 

Any source can be patched to any destination. For example a Bus Element can be patched to a 
Track Input, for recording purposes. To illustrate, select the Category Sub-Bus Out (the outputs 
of all the Sub Busses.) The expanded view will show the Sub-Bus elements separately, and they 
can be selected and patched to track inputs for recording. 

To deselect all the signal paths you have selected, touch the Clear button. 

What are the Categories? 

Each category name has two parts. The first part can be  
Track  – a recording track  
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Live – a Live Feed, which is a full-featured channel bringing audio directly to 
a bus 

Main – the Main mix bus 

MT-Bus – a Multi-track bus, as used in traditional mixing systems 

Sub-Bus – a multi-Element bus used for extra mixing functions 

Aux-Bus – a mono or stereo bus, tied to the Auxiliary sends on the channels 

Mon – shows the elements of the Control Room and Studio monitor paths 

Analog – an analog physical input or output 

Digital – an AES-EBU physical input or output 

MADI – a MADI physical input or output 

The second part can be: 
In  – the input of a signal path (not a physical input) 

Out  – the output of a signal path (not a physical output) 

Direct  – each signal can have a Direct Output 

Send  – Insert Send from a signal path 

Return  – Insert Return to a signal path 

Talkback  – the Talkback system – shows Comm1 and Comm2 

Inputs  – physical inputs (analog or digital) 

Outputs  – physical outputs (analog or digital) 

So, for example Analog Inputs means the physical analog input ports, while Aux-Bus Send 
means the Insert Sends from the Aux Busses.  

Patching Using the Selection Panel 
When using the Selection Panel, slightly different techniques are used, depending on the type of 
signal path being patched. 

Patching Inputs 
Each Track Feed can be fed from a physical input or a Bus Element.  

When a disk recorder track is armed an input can be recorded on to the track and monitored 
through it.  

Physical inputs can also be patched to Insert Returns. This is done in the Insert Config Menu, 
which is described later in this chapter. 

Analog And Digital Inputs 
Physical inputs are numbered 1 to 64 Analog and 1 to 64 Digital, of which the latter can be 
further extended to include1 to 64 AES/EBU and 1 to 256 MADI. MADI inputs are only present if 
your system includes one or more SX-48 units. 

 During patching the Inputs are represented by the Track Feed Keys. You can toggle between 
Analog and Digital inputs, and between AES and MADI inputs when digital is selected. 

Patching Physical Inputs To Tracks 
The patching procedure requires the operator to first select the destination(s), then select the 
source(s). To patch physical inputs to Feeds: 
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Step 1 Press the Patch I/O key. 

Step 2 Select the destination tracks using the Track Feed keys in the Selection Panel (or you 
can use the feeds already selected). 

Step 3 Press the {Patch} soft key. 

Step 4 If you want to use digital inputs, toggle the input type using the {Analog/Digital} 
soft key. To change the digital input type use the {AES/MADI} soft key.  

Step 5 Select any number of physical inputs by holding one down, then optionally selecting 
others, or double pressing the last in a range, before releasing the original.  

The physical inputs are patched to the tracks successively until the feeds are all used. If the 
physical inputs are all used before the tracks are, then patching starts again from the first 
physical input. 

For example, selecting only one input will cause it to be patched to all selected tracks. 
Selecting two inputs will cause them to be alternately patched to the selected tracks. 

If any of the inputs are used elsewhere, you will be asked to share, remove or replace.  

Input Gain and Phase 
Analog and Digital inputs can have digital gain or attenuation, and phase reversal applied at the 
input. Inputs are selected by first selecting the signal paths that they are patched to. 

There are two ways to set input gain and phase. You can use the mixer screen or the track 
keys. 

Using the Mixer Screen 

Step 1 Right-click the signal path whose input gain and/or phase is to be set. 

The DREAM II Virtual Channel is displayed. 
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The Input section is in the top left. 

 

Step 2 Click on the Trim control and drag the mouse to change input gain. 

Step 3 Click the Phase control (P) to toggle input phase. 

You can also adjust Mic gain and switch 48 V phantom power on and off, if using 
Fairlight mic preamps. 

Using the Track Keys 

Step 1 Press the Patch I/O key. 

Step 2 Select the tracks whose inputs you wish to adjust. 

Step 3 Press the {Gain} soft key. 

If all the inputs of the selected tracks have the same gain value, that value is shown in 
the LCD below the {Gain} soft key as an absolute value {ABS}, otherwise this field is 
initialised to 0 dB and is displayed as a relative value {REL}. {ABS} represents the 
absolute value of all Inputs. {REL} represents a trim or relative offset value applied to 
all inputs. 

Step 4 Use the Jog wheel or +/- keys to adjust the relative gain in real time or use the numeric 
keys to enter an absolute value and press Enter to complete. 

Step5 Press the {Phase} soft key if you wish to toggle the phase of the selected inputs. 

Patching One Input To Multiple Signal Paths 
It is possible to patch the same physical input to many different signal paths, and have it heard 
on many of them at the same time. This includes Live Feeds, Track Feeds, and Insert Returns. 
The exception is that only one of a group of Track Feeds with the same physical input can be 
armed at one time. 

The user is prompted before sharing of physical inputs takes place. So, when a physical input is 
selected as part of the patching operations described above, if it is already being used by 
another signal path, the following warning message appears: {One or more inputs already 
patched. Do you want to share, replace or remove?} Press the {Share} or {Replace} 
soft key to choose the patching option you require. Press the input selection key again to 
remove it from the selection. 

When {Share} is selected, inputs that are already patched to existing destinations remain 
patched to those destinations, and are also patched to the currently selected destinations. 

When {Replace} is selected the input is unpatched from its current destinations and patched to 
the currently selected destination. 

Unpatching Inputs 
To remove input patching from a set of one or more feeds, press the Patch I/O key, select the 
feed and press the {unpatch inputs} soft key. 
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The Remove Patching command on the Patch I/O screen can also be used for this function. 

Patching Insert Returns 
See the section below: Patching Insert Sends and Returns. 

Patching Outputs 
Physical outputs can be patched from buses, insert sends, direct outs and monitor outs.  

Using the Patch I/O screen is the same as for inputs, with appropriate selections. 

Patching Insert Sends and Returns 
Inmost cases, patching is easiest to achieve using the Patch I/O menu. For instructions, please 
see Using the Patch I/O Screen, page 11. 

Alternatively, to select physical outputs for insert sends: 

Step 1 Select the target signal path by clicking on the Mixer screen, or using the CALL menu. 

Step 2 Press the Insert key to open the Insert Menu. 

 

Step 3 Press the {Patch} soft key in the LCD menu. 

Step 4 Use the {SENDS/RETURNS} soft key to choose whether you are patching send outputs 
or return inputs. 

Step 4 Press the {Analog/Digital} soft key, and the {AES/MADI} soft key to choose a digital 
input or output, if required. 

Step 5 The track feed keys may now be used to select an input or output for the insert send.  

If the selected path is a bus or a link group the inputs or outputs are selected for one 
element at a time. 

Step 6 Each insert send may be patched to a single output or multiple outputs. Press the 
{SINGLE/MULTI} soft key to select single or multi mode. In multi mode it is possible to 
select multiple outputs for one insert send. 

Step 7 In SINGLE mode Press a track key to select the input or output for the current feed. 

If the selected path is a bus or link group, in SINGLE mode the current bus or link group 
element is advanced automatically when an output is selected. Press a track key to 
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select the input or output for the current bus or link group element. 

The bus or link group elements advance in the following order: Left, Left Centre, 
Centre, Right Centre, Right, Left Surround, Centre Surround, Right Surround, Boom. 
Elements that are not in the current bus or group format are not displayed. 

To skip the current bus or link group element press the {Next} soft key. 

To remove patching for the current bus or link group element and leave it with no 
output, press the {Blank} soft key. 

In MULTI mode outputs for the selected feed, bus or link group element may be toggled 
ON or OFF by pressing the corresponding Track keys. If the key is flashing, pressing 
the key will remove it from its current source and patch it to the current element. Press 
a track key to add it to the outputs for the insert send. 

To advance to the next bus or link group element press the {Next} soft key. 

Press the Insert key to return to the previous mode or select another path to patch by 
clicking on the Mixer screen. 

Inserts may be switched in and out of circuit by pressing the {ON/OFF} soft key. 

Patching Direct Outputs 
In most cases, patching is easiest to achieve using the Patch I/O menu. For instructions, please 
see Using the Patch I/O Screen, page 11. 

Alternatively, any feed or bus may be sent to a Direct Output. Direct Outputs may have one or 
more physical outputs. To select physical outputs for Direct Outputs: 

Step 1 Click in the Mixer screen, to select a feed or bus. 

Step 2 Press the Direct Key. 

 

Step 4 Press the {Patch Outputs} soft key in the LCD menu.  

Step 5 Use the {ANALOG/DIGITAL} and {AES/MADI} soft keys to choose the desired type of 
output. 

The track feed keys may now be used to select outputs for the Direct Out.  

Outputs of the selected type (Analog and AES/MADI) currently patched to the selected 
feed or bus element are brightly lit. 
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Outputs of the selected type (Analog and AES/MADI) currently patched to other sources 
flash off to dim. 

Outputs of the selected type (Analog and AES/MADI) currently available are dimly lit. 

Outputs of the selected type (Analog and AES/MADI) that are not fitted are unlit. 

If the selected path is a bus or a link group the outputs are selected for one element at 
a time.  

Step 6 Each direct out may be patched to a single output or multiple physical outputs. Press 
the {SINGLE/MULTI} soft key to select single or multi mode. 

Step 7 In SINGLE mode Press a track key to select the output for the current feed direct out. 

OR 

If the selected path is a bus or link group, in SINGLE mode the current bus or link group 
element is advanced automatically when an output is selected. Press a track key to 
select the output for the current bus or link group element direct out. 

The bus or link group elements advance in the following order: Left, Left Centre, 
Centre, Right Centre, Right, Left Surround, Centre Surround, Right Surround, Boom. 
Elements that are not in the current bus or group format are not displayed. 

To skip the current bus or link group element press the {Next} soft key. 

To remove patching for the current bus or link group element and leave it with no 
output, press the {Blank} soft key. 

In MULTI mode outputs for the selected feed, bus or link group element may be toggled 
ON or OFF by pressing the corresponding Track keys. If the key is flashing, the system 
will warn you that the output is used by another signal path. Press a track key to add it 
to the outputs for the direct out. 

To advance to the next bus or link group element press the {Next} soft key or press 
another speaker mute key to select that bus element out of sequence. 

Press the Direct Config key to return to the previous mode or select another bus to 
patch by pressing a bus selection key. 

For a signal path with ports established for Direct Output, the {Direct ON/OFF} soft key is 
used to turn the direct output on and off. 

Direct Out Pre/Post 

Step 1 Click in the Mixer screen, to select a feed or bus. 

Step 2 Press the Direct Key. 
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Step 4 Press the {Pre/Post} soft key in the LCD menu to toggle the output between pre and 
post fader. 

The Mixer screen shows the position of the Direct Output in the Fat Channel. 

 

Direct Out 
Pre Fader 
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Direct Out Gain 

The direct output signal can have gain or attenuation applied prior to the output. Press the 
{Gain} soft key and turn the jog wheel or use the numeric keys and press Enter to set the 
gain. If a bus or link group is selected, all bus elements or link group members are set to the 
same absolute direct output level. To alter the direct out level of a single member of a link 
group, individually select the member by holding down the BLUE key and pressing the selection 
key. 

Monitor Outputs 
Patching monitor outputs is covered in “Monitor Outputs” on page 49. 

Configuring Bus Formats 
The Main Bus, Sub-Buses and Aux Buses may be configured in mono, stereo or multi-channel 
surround formats. Each bus comprises individual bus element signal paths from one up to a 
maximum of eight, these elements include left, right, centre, etc. Bus formats must be 
configured prior to use. 

The Format Menu 
The Format Menu is used to set the format i.e. the number and type of independent bus 
elements comprising each bus: 

Step 1 Press the Format Key. 

Step 2 The Channel Select page is shown on top of the Mixer screen. Select one of Main, or a 
Sub Bus, Aux Bus or MT (Multi-Track) Bus by clicking its tile on the screen. 

The format of the selected bus is displayed in the LCD. 

Step 3 Available formats for the selected buses are displayed on the LCD. Press a soft key to 
select the format required. 

The formats available for Main and Sub-Buses are: 
Mono; Stereo; LCR; LCRS; LCRSS; 5.1; 6.1 (L,C,R,LS,CS,RS,B); 7.1; and OFF. 

Direct Out 
Post Fader 
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Note that the Main bus can not be set to {OFF} – it must have a format of at least 
{Mono}. 

The formats available for Multi - Track Buses are:  {Mono} and {OFF} 

The formats available for Aux Buses are: {Mono}, {Stereo} and {OFF 

Bus elements are assigned automatically from a finite pool of 48. As formats are defined for 
each bus, the number of available bus elements is reduced. The number of remaining elements 
available is displayed on the LCD. 

Assigning Signals to Buses 
Feed signals are routed to Main, Sub and Aux buses via a panner element in each signal path. 
Feeds can also be assigned to Multitrack buses which are mono buses used for sub-mixing or 
recording to disk. Sub-Buses may also be assigned to the Main Bus if they are used for sub-
mixing or as separate stems.  

Assigning Feeds to Buses 
To assign signal paths to buses: 

Method 1 

Step 1 Press the Assign key 

 

Step 2 The Channel Select Panel is displayed. Click to select the destination bus to which you 
want to assign signal paths. This can be the Main Bus, any Sub Bus, or any MT bus. 

The selected bus key will be highlighted. The keys of Track Feeds already assigned to 
that bus will light up. 

Step 3 Press any Track key to toggle its assignment on or off. You may use double-clicking and 
hold-double clicking to select exactly one or a sequence of keys respectively. 

Live Feeds must be assigned from the screen. Click the Lives button on the Channel 
Select screen and select the Live Feeds to assign to the current bus. NOTE: Tracks and 
all other signal paths can also be assigned from the screen. 

Press the All Tracks soft key to assign all tracks to the selected bus. 

Press the All Live soft key to assign all Live Feeds to the selected bus. 

Press the deassign all soft key to deassign all sources. 
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Step 4 Press the Bus Assign key to return to the previous mode or select any other mode. 

Note: once the Main Bus is selected as the destination bus, Sub-buses can be added to the 
source selection as described below. Press the Main key again to de-select the Main bus as the 
destination before selecting a Sub-bus as a new destination for bus assignment. 

Method 2 

Step 1 Right Click a Track or Live Feed on the Mixer screen. 

Step 2 Use the lower right hand section to toggle assignments to buses. 

Step 3 Use the + and – buttons to move to the next/previous channel. 

Step 4 When finished, right-click anywhere in the Virtual Channel to make it disappear, or 
select an editing mode. 

 

Aux to Main Bus 
Aux buses cannot be assigned to the Main Bus.

Click to assign Track 11 to 
the main bus (MIX) and 
sub-busses (B1 to B8) 

Click to select 
next/previous 
channel 

Click the + and – buttons 
to assign Track 11 to a 
Fader Group. 
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Chapter 6 -  Monitoring 

Introduction 
Satellite-AV provides flexible choices of monitor sources, formats and speaker destinations. It 
also supports automatic fold down or up into narrower or wider formats, allowing, for example, a 
5.1 mix to be checked in stereo monitors. 

Monitor Sources 
You can choose between three sources for the monitoring in Satellite-AV. They are: Main Bus, 
Sub-Bus 1 or Aux 1. 

To choose amongst these sources: 

Step 1 Press the Monitor key. 

Step 2 Choose one of the three sources in the upper row of soft keys. 

Step 3 To exit, choose another mode. 

Monitor Speaker Sets 
Satellite-AV supports three sets of speakers, called MAIN, Near and SpkSet2. Each of these can 
be set up with its own surround format and physical outputs from the system to its amplifiers. 
One set of monitors can be switched on at a time. 

Where the current source surround format is different from the current speaker set surround 
format, the Monitor Matrix provides the necessary fold-up and fold-down. 

To choose a speaker set: 

Step 1 Press the Monitor key. 

Step 2 Choose one of the three speaker sets in the lower row of soft keys. 

Step 3 To exit, choose another mode. 

Monitor Matrix 
The Monitor Matrix is a built-in 8 into 8 mixer. It takes the source signals (up to 8) and feeds 
them to the outputs (up to 8). Normally this is just passing the audio from input to output, but 
the user may choose a different monitor format, like folding a 5.1 signal down to stereo for 
compatibility checking. In this case the mixer will mix the 6 source signals down to two output 
signals. 

Setting Up Speaker Sets 
To set the format and select the physical outputs for any of the monitor sets follow the steps 
below. All settings must be saved, see “Saving Monitor Setups” on page 54. 

Step 1 Press the Monitor key. 

Step 2 Press the {Patch Outputs} soft key. 
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Step 3 Choose one of the three speaker sets in the lower row of soft keys. 

Step 4 To determine the number of outputs required, you must specify the format of the 
speaker set. Press the Format soft key to cycle through the available formats. These are 
{None}, {Mono}, {Stereo}, {LCR}, {LCRS}, {LCRSS}, {5.1}, {6.1}, {7.1}. 

Step 5 Select the type of physical outputs you wish to patch to by pressing the 
{ANALOG/DIGITAL} and {AES/MADI} soft keys. By default, analog is selected. 

Step 6 Track keys now represent the physical outputs. The output key patched to the current 
Monitor Element is brightly lit. Output track keys used for other purposes flash. Output 
track keys available for patching are dimly lit. 

Select the output for the first speaker. 

Step 7 Use the {next} soft key to move to the next Monitor Element. 

Step 8 Select the speakers to patch one by one, by pressing each speaker mute key and 
following the patching procedure described above. 

If you wish not to have an output for a Monitor Element, press the {blank} soft key, 
then System Outputs 

Step 9 Press the {end} soft key to finish patching, or select another mode. 

Specific outputs may be defined for use with control room monitors only. System output ports are 
only available for patching in the Monitor Setup Patching page. System ports are defined in the 
I/O Config.TXT file as described in “The I-O Config.TXT File” on page 162. Use system output 
ports for patching your control room monitors to avoid accidentally patching other sources direct 
to the power amplifier inputs. 

Naming Control Room Speaker Sets 
Alternative speaker sets may be given more meaningful names specific to the current installation.  

Step 1 Press the Monitor key. 

Step 2 Press the {Patch Outputs} soft key. 

Step 3 Press the soft key for the speaker set you wish to name e.g. {SpkSet1}. 

Step 4 Press the {Name} soft key. 

Step 5 Make sure that the Mixer Screen has focus by clicking anywhere on it. Type the name on 
the PC keyboard and press Enter. Use a maximum of seven characters.  

Trimming Relative Speaker Levels 
The level of each speaker in a speaker set can be adjusted independently. This is useful for 
setting surround speaker levels and compensating for different amplifier gains. 

Step 1 Press the Monitor key. 

Step 2 Press the {Patch Outputs} soft key. 
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Step 3 Press the soft key for the speaker set you wish to adjust e.g. {SpkSet2}. 

Step 4 The output for the first speaker element is highlighted (if one has been patched) 

Step 5 Press the {Gain} soft key and use the jog wheel or +/- keys to adjust the gain in real 
time, or use the numeric keys and press Enter to complete. 

Step 7 Use the {next} soft key to move to the next Monitor Element. 

Step 8 Select the speakers to adjust one by one and follow the gain procedure described above. 

Monitoring Controls 
The Control Room monitoring controls include: 

Monitor Level 
The Monitor Level control provides direct control of the control room listening level. This is 
achieved in two ways: 

1. Press the Monitor key and use the Jogger Wheel to control level. 

2. Press the Monitor key and use the mouse to control the fader in the Mixer screen Fat 
Channel. 

Dim and Mute 

The {MUTE} soft key in the Monitor menu cuts the monitor output.  

The {DIM} soft key in the Monitor menu reduces the monitor level by a fixed amount.  

Saving Monitor Setups 

 

The BLUE Utils menu offers the {Update Sys-File} soft key for storage of system settings. 
System Files are stored in the C:\Program Files\ Fairlight\FMC\Data\ directory. 

Step 1 Hold down the BLUE key and press the Utils key to enter the Utils menu.  
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Step 2 Press the {Update Sys-File} soft key to store the system settings. This information is 
stored in the following files: 

Monitor_Sources.TXT - patching and formats of external monitor sources and Monitor 
Sets. 

Speaker_Sets.TXT - patching and formats of all speaker sets. 

Setup_Variables.TXT - Call Follow state and Satellite-AV brightness. 

Solo 
Individual feeds may be soloed into the monitoring system. Currently, only solo-in-place or SIP is 
supported. SIP mutes all other feeds leaving only the soloed feeds feeding the bus being 
monitored. SIP supports monitoring in any format.  

Solo Contrast 
When a feed is soloed in SIP mode all other feeds are reduced in level by the amount set in the 
Utils menu. To adjust the solo contrast: 

Step 1 Hold down the BLUE key and press the Utils key. 

Step 2 Press the {Solo} soft key and turn the jog wheel to set the gain reduction level. The 
range is 0 to -100dB, -100dB is off. 

Disk Recorder Solo 
The disk recorder solo system allows a selection of tracks to be soloed. For details of the disk 
recorder solo and mute functions, see “Solo and Mute” on page 127. 

Naming Feeds and Buses 
Feeds, link groups and buses can be named from the Call menu. 

Step 1 Press the Call key to access the Call menu. 

Step 2 Press a track, live or bus selection key to call a path to the master fader. 

Step 3 Press the {name} soft key and type a name on the PC keyboard. 

Step 4 Press Enter to store the name. The name will now appear on the fader LCD and on the 
mixer display. 

Press the Tab key to enter the name and step to the next feed. Hold the Shift key and 
press Tab to move to the previous feed. 
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Chapter 7 -  Recording 

Introduction 
Satellite-AV can record up to 64 simultaneous tracks to disk. The following chapter describes how 
to configure and then record audio into the system.  

Project Set Up 
 The steps for setting up a new project are described in Chapter 3 – Projects. 

Sync Setup  
The current sync setup can be changed at any time by selecting Smart Pane->Setup from the 
View Menu, or by pressing the Setup key on the console.. 

 
Sample rate The system supports sample rates up to 192 

kHz. The number you enter here can be 
changed in the Sync display up to the time of 
your first recording, but after that it is fixed for 
subsequent recordings.  

Frame Rate The value you place here can be changed in 
the Sync display at any time afterwards. It 
should match the incoming timecode format for 
correct synchronisation. 

Bit Depth The system supports sample depths of 16 or 
24 bits. You can change this value at any time, 
affecting subsequent recordings. All previously 
recorded audio is played back at its recorded 
sample depth. Note that 20-bit recording, 
which was supported in earlier Fairlight 
products, is no longer a choice. 

Clock Sync Source Choose the clock signal to be the master time 
reference for the system.  
Choices are: 
SX-20 Internal – uses the internal clock of the 
SX-20 
SX-20 Video – uses the video input signal 
coming into the SX-20 
SX-20 WCLK – uses a WCLK signal coming into 
the SX-20 
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Project Frame Rate 
The frame rate (timecode format) can be changed at any time, but should be set to the local 
standard, or to match the format of the video material or project currently being worked on.  

Step 1 Press the Setup key. 

Step 2 Press the TC FORMAT soft key. 

Step 3 Turn the jogger wheel to select the desired timecode format. 

Select Non-Drop or Drop-Frame (if applicable). 

Step 4 Press Enter. 

Setting Frame Rate using the mouse: 

Step 1 From the View menu select Smart Pane, then Sync Setup 

Step 2 Click in the Frame Rate drop list. 

Step 3 Select the desired frame rate, including Non-Drop or Drop-Frame (if applicable) 

NOTE: 

1. The sample rate is also fixed if an import from another Project is performed 

2. The sample rate and frame rate jogger wheel selection can also be performed using the 
+ and - keys on the numeric keypad or the numeric keys 0 to 4. 

Patching Inputs to Track Feeds 
This is described in detail in Chapter 5, Patching and Routing. See Patching Physical Inputs to 
Track Feeds. 

Input Gain and Phase 
This is described in detail in Chapter 5, Patching and Routing. See Input Gain and Phase. 

Arming Tracks 
An input can only be recorded on one track at a time. If an input is patched to more than one 
track, arming one of these tracks will disarm any other track patched to this input. 

The transport must be in STOP to monitor the inputs. To arm a track: 

Step 1 Press Arm. Track selection keys flash red to indicate the available tracks. 

Step 2 Select track(s) to be armed by pressing the track selection keys. 

Any number of tracks can be armed at the same time, as long as your system contains enough 
channels to play them.  

The currently selected track feed can also be armed from the Path Configuration section of the 
Channel Panel. 
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Arming Tracks with the Mouse 

A track may be armed by clicking on the disk at the left of the Track Selection Panel. 

 

Arm on the Fly  
Normally tracks are armed before you put the system into record, but it is possible drop in or out 
of record on specific tracks while the system is recording using any of the arming methods 
described above. If the input patching for the track is not unique (i.e. it tries to record an input 
that is already being recorded on another track) the first track disarms. 

Metering Input Levels 
The input levels to the armed tracks are shown as vertical bargraphs at the top of the screen. 
These are seen on the video screen as soon as you enter the Arm Menu. For tracks that are not 
armed for record, meters show the playback levels.  

Recording  
Step 1 Locate the transport to where you want to start recording, then press PLAY and 

RECORD together. 

Step 2 Press STOP or PLAY to end the recording. It is also possible to drop tracks in and out of 
record using the track keys in the Arm Menu. 

Click here to 
arm Track 4 
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Recording Types 
Recording is always non-destructive, creating new data and clips. Note that earlier Fairlight 
products included overwrite recording, but this is no longer available. 

ARM Mode 

The fifth soft key in the Arm Menu sets the operating mode of the arm menu. In {Ready} mode 
the track keys are used to arm tracks for recording. Armed {Ready} tracks play back existing 
clips until dropped into record. When in record the input signal is passed through to the output of 
the track feed. Armed tracks show the input highlighted in red on the meters display on the video 
screen and on the track keys. 

In {Thru} mode the track keys are used to monitor the input of a track. Tracks can not be armed 
in {Thru} mode. {Thru} tracks show the input highlighted in green on the meters display on the 
video screen and on the track keys. 

Monitoring Inputs 

The {MONITOR} soft key in the Arm Menu determines what is monitored on armed tracks in the 
various transport modes. Press the {MONITOR} soft key and use the jog wheel or +/- keys, then 
press Enter to choose amongst the modes described below.  

The comprehensive input monitoring options cover all recording requirements. The five monitor 
modes for armed tracks are summarised below: 
 REW FF STOP PLAY REC JOG/SH 

{INPUT} Input Input Input Input Input Input 

{AUTO} Input Input Input Track Input Track 

{RECORD} Mute Mute Mute Track Input Track 

{MUTE} Mute Mute Mute Track Mute Track 

{REPRO} Mute Mute Mute Track Track Track 

These settings support the following example applications: 

• {INPUT}: The track feed always monitors input. Use INPUT when the studio monitoring is 
fed through headphones, or when recording from tape and the desire is to punch in, 
cued from source material rather than playback material. 

• {AUTO}: The track feed monitors the input on record and track on playback. Use AUTO 
when the studio monitoring is fed through cans for voice-over recording or over-dubs. 
Choose {AUTO} to allow cueing from the track then switching to the microphone during a 
record drop-in. 
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• {RECORD}: The track feed monitors input on record only. The track is monitored on 
playback and mutes when stopped. Use {RECORD} when the monitor system must be 
muted when system is in stop to avoid feedback. 

• {MUTE}: The track feed only monitors the track on play back and is muted in all other 
states. Use {MUTE} when the studio monitoring is fed through speakers. This can be 
useful for foley stages. 

• {REPRO}: In {REPRO} mode the track feed monitors the track on record and playback 
and mutes when in other modes. 

Note: When recording editor macros, number-pad digits can be used to select mode in Blue-
Monitor: 0 = AUTO 1 = RECORD 2 = MUTE 3 = REPRO  

Assigning Track Feeds to Buses 

Track feeds must be assigned to a bus to be monitored through the studio monitors. This is 
described in detail in Chapter 5, Patching and Routing. See Assigning Feeds to Buses. 

Selecting a Monitor Source 

This is described in detail in Chapter 6, Monitoring. See Selecting a Control Room Monitor Source 
on page 51. 

Punch In / Punch Out 
It is possible to enter record while playing back from disk on Satellite-AV.  

While playing, start recording by pressing the RECORD and PLAY buttons together. To drop out 
of Record, press the PLAY, STOP, JOG, REW or FF buttons. 

You can drop in or out on individual tracks whilst recording by pressing the track keys, whilst the 
Arm menu is active. 

Each time you enter Record you will create a new clip on each armed track. These clips are 
placed over any other clips that they encounter on the same tracks. The monitoring switches 
from recorded material to live as you enter Record, exactly as though you were erasing the 
existing audio. 

Clips covered by new recordings may be retrieved by pressing BLUE TAKES key and selecting 
the desired clip from the list of “takes” hidden on the track. 

By enabling Display Layering in the View Menu, you can see the layers of clips on each track. A 
clip can be lifted in the layer order by clicking on it with the mouse and dragging upwards. 

Automatic Drop-in 
Pre-determined drop in and drop out points may be activated using the Machine Control section 
of the Satellite-AV. See “Using the ADR Functions” on page 112 for further details.
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Chapter 8 -  Edit ing 

Introduction 
DREAM II offers a combination of hardware and mouse-based editing. The two methods are 
complementary and are designed to be used at the same time. 

Edit Modes 
Binnacle editing uses six modes, selected on the outer ring of keys: 
Copy copies the selection to the clipboard (Enter pastes it into the tracks) 

Cut cuts the selection to the clipboard (Enter pastes it into the tracks) 

Erase erases the selection. 

Trim retracts or extends the heads or tails of clips. 

Slip one-step movement of clips through time (not using clipboard). 

Fade fades or cross-fades the selection. 

Once a Binnacle mode is selected, it remains current until another mode is selected. 

Cut and Paste  

Whole Clip 
To cut and paste a clip: 

Step 1 Select a track and move a clip under the cursor. 

 

Step 2 Press the Cut key on the Binnacle (if not already selected). 

Step 3 Press the Clip key 

The clip is red because 
it is touching the 
cursor. 
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 Step 4 Select another track (and/or move to another location) 

 

Step 5 Press the Enter key to paste the clipboard. 

 

Head 
This time we’ll only work with the Head of the clip. That is the part before the cursor. 

Step 1 Select a track and move a clip under the cursor. 

We see the clip’s “ghost”. 
It’s a picture of the 
clipboard ready to be 
pasted in. 

The ghost shows where 
the clipboard contents 
can be pasted. 

The clip is pasted. 
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Step 2 Press the Cut key on the Binnacle (if not already selected). 

Step 3 Press the Head key 

 

Step 4 Select another track (and/or move to another location) 

 

Step 5 Press the Enter key to paste the clipboard. 

Only the head goes on 
to the clipboard.  

The ghost shows a head-
shaped clipboard ready to be 
pasted. The original tail is now 
Blue, because its track is not 
selected.  

The clip is red because 
it is touching the 
cursor. 
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Range 
You can make a range that specifies exactly which part of the clip is affected. The easiest way is 
like this (more about ranges later): 

Step 1 Move the transport where you’d like to start the range. 

Step 2 Press the From key 

Step 3 Move the transport where you’d like to end the range. 

Step 4 Press the To key 

 

Now we’ll cut and paste the audio in the range. 

Step 1 Choose the track and set the range (we’ve just done this) 

Step 2 Press the Cut key on the Binnacle (if not already selected) 

Step 3 Press the Range key 

The clipboard (former 
head) is pasted. 

The range is marked in 
red. 
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Step 4 Select another track (and/or move to another location) 

 

Step 5 Press the Enter key to paste the clipboard. 

 

Notes about Cut and Paste 

Tail 

Works the same way as Head, but cuts the later part of the clip 

Range and Head 

When a range is active, pressing the Head key cuts the audio from the start of the range to the 
cursor. This will not work if the cursor is not in the range. 

Range and Tail work similarly together. 

The audio in the range 
is moved to the 
clipboard. We see the 
ghost. 

The ghost moves to the 
new track. 

The clipboard (former 
range) is pasted. The 
range persists after the 
edit. 
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Multiple Clips and Tracks 

When there is no range, the target for editing is all the clips on selected tracks that are touching 
the cursor. It’s easy to tell which, because they are always red. 

When there is a range, the target is all the clips (and parts of clips) on selected tracks that are 
inside the range. Again, the target clips are always red. 

An exception – with a range you can use the mouse to deselect a clip. To do this, hold down the 
Ctrl key and click with the mouse. The clip will turn blue, showing that it is no longer selected. 

You can also extend the selection using Ctrl-mouse-click on a clip. This will cause the range to 
expand so that it includes the newly selected clip, and it will preserve the existing selection  as 
well. 

Pasting 

Pasting the clipboard (use the Enter key) means putting a copy of it at the current position, on 
whatever tracks are selected. 

You can paste the clipboard contents at any time, not just after a cut operation, and as often as 
you like.  

If there are already clips at the place where you paste, the clipboard is placed “on top” of the 
existing clips. Only the top layer is heard, unless there is a crossfade between layers (more about 
that later). 

The “shape” of the clipboard’s track selection is preserved when pasting, regardless of track 
selection at that time. For example, if you copy clips on tracks 1 and 3, then select only track 8 
and press Enter, the clipboard will be pasted on tracks 8 and 10. The first track on the clipboard 
is always pasted on the lowest-numbered track in the selection. 

Variations 
There are a few extra keys which change the functions of Cut and Paste. 

All Layers 

Sometimes clips are stacked in layers. Of course we only hear the top layer, or crossfades 
between the top and second layers (more about crossfades later). 

You have the choice of cutting only the top layer, or all the layers. The All Layers key controls 
this choice. When it is on, you will cut all the layers, and they’ll be placed on the clipboard, ready 
to be pasted. When it is off, you will cut only the top layer. 

Note that All Layers only works with a range. 

Hint: if you want to see all the layers, press the Blue-Takes key. 

Razor 

Sometimes it is useful to cut the time out of a track, not just the audio. This is similar to cutting 
tape. 

To cut time as well as audio, turn on the Razor button. This will automatically turn on Range 
and All Layers. 
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As soon as you cut something (Head, Tail or Range) the time they occupied is also cut, and all 
the following clips move earlier. 

When you paste (press Enter) with Razor switched ON, the clipboard audio is inserted into the 
track, pushing all the following clips later. This is true even if Razor was not ON when the clips 
were cut to the clipboard. (Cut and Paste are really independent commands, each responsive to 
the Razor setting.) 

Track Sel 

A handy device for moving between tracks is the Track Sel button. If you hold it down and turn 
the Jogger Wheel, the whole track selection will move up or down. 

Two-Handed Editing 

Using two hands for cut and paste can save a lot of time. The key is to hold down the “action” 
key – Head, Tail, Clip or Range – then select the destination timecode and tracks – then 
release the action key to paste the clipboard. 

Example 1 

Press down the Clip key (don’t release it yet!) 

With your other hand, jog the transport forward 

Release the Clip key – the clip you cut is now pasted where you jogged. 

Example 2 

Press down the Clip key 

With the same hand, press down the Track Sel key 

With your other hand, turn the jogger wheel to change the track selection 

Release the Clip key – the clip you cut is now pasted on a different track. 

With practice, two-handed editing can substantially increase your efficiency at repetitive editing 
tasks. 

Copy 
Copy works exactly the same way as Cut, except that the audio is not removed to place it on 
the clipboard, only copied. Pasting after copy is the same as after cut. 

Erase 
Erase works exactly the same way as Cut, except that the audio is not placed on the clipboard. 

The clipboard remains unchanged, so its previous contents are ready to paste at any time. 

Edit Soft Key Commands 
The following soft keys are available when the Cut, Copy or Erase Binnacle modes are current. 
{split clip} Cuts the clip into two pieces at the cursor position. 

{mute clip} Silences the clip 
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{cleave clip} Removes the link between stereo linked clips. 

{reverse} Creates a reversed version of the audio in the selected clip(s) and 
replaces the original with this reversed version. 

{Ghost On} Toggles the “ghost” image on and off. Some people prefer working 
without it. 

Range On Soft Key Functions 

The following additional commands are available when the Cut, Copy or Erase Binnacle modes 
are current, if a Range is present. 
{split range} Cuts any clips lying across the ends of the range into two pieces at 

those range ends. 

{fill} The {fill} function is used to automatically repeat a section of audio to 
fill a Range on a track to create background fills or buzz tracks. The 
audio used for the fill is the clip currently on the clipboard from the last 
cut or copy function. Multiple copies of the source may be needed, in 
which case an overlap is used (see below). 

{b/f fill} Reverses the audio in every second copy of the clipboard used for filling. 
This can give a smoother effect. 

{overlap} Controls the length of overlap between pieces of audio used in the {fill} 
command. 

To use the {fill} function: 

Step 1 Copy (or Cut) the desired audio to the clipboard. The cursor’s sync point will be 
maintained 

Step 2 Create a Range encompassing the area to be filled. 

Step 3 Press the {fill} soft key. 

Razor Soft Key Functions 

When Razor On is selected the LCD menu changes:   
{insert fill} The filled audio is inserted into the track, not written over the original 

audio in the range. 

{insert b/f 
fill} 

The backwards/forwards filled audio is inserted into the track, not 
written over the original audio in the range. 

{overlap} Controls the length of overlap between pieces of audio used in the {fill} 
command. 

{insert space} Silence will be inserted from the start of a Range for the duration of the 
Range. 

Trim 
Trimming allows clips to be resized. Trim commands are used to set the head and tail of clips, to 
determine how much of the original recording is played by the clip. 
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Trimming may shorten a clip, or extend a clip if it is playing less than all of the original recording. 
This will be the case if the clip was imported with handles or if the original clip has been edited. 

Head 
Trim Head and Trim Tail are the most common uses of Trim 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Trim key on the Binnacle (if not already on) 

Step 3 Press and release the Head key 

Step 4 Move the transport forward a few frames (jog or play) 

Step 5 Press Enter 

The head of the clip is placed at the cursor, which is now shorter. The effect is just like erasing 
the head of the clip. Its sync remains as before, but it starts at a later time and a later point in 
the audio. 

Step 6 Jog backward a few frames and press ENTER 

Now the head is moved earlier, revealing more of the audio. You can keep jogging and pressing 
ENTER as long as you like, until you are satisfied with the position of the head. 

Two Handed Trimming 

This is a more powerful method, which is worth learning. 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Trim key on the Binnacle (if not already on) 

Step 3 Press the Head key (and hold it down) – the head is extended to show the full extent of 
the original recording. 

Step 4 Jog or play the transport – you can listen to the audio and choose the right position. 

Step 5 Release the Head key – the head is placed at your current position. 

Limit to Trim 
When extending a clip, the end of the recorded audio will be reached eventually. After that it is 
not possible to extend the clip further. 

Tail 
Same as Head, but the later part of the clip is trimmed. 

Clip 
Trim clip changes both ends of the clip at once. Its purpose is to preserve the length of the clip, 
but access an earlier part of the recorded audio. Not commonly used. 
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Range 
Ranges cannot be used with Trim. 

Multiple Tracks 
Works as expected. All the red clips will be trimmed to the same point in time. 

Soft Keys in Trim Mode 

{sync point} Pressing the {sync point} soft key creates a sync marker within the selected 
clip(s) at the cursor position. This is shown as a yellow mark in the clip, and 
can be used to visually locate an important moment. 
To change the sync point, press {sync point} at the new location. There is 
only one sync point per clip. 

Trim Edit Options 
Trim is usually applied to a single clip or selections across tracks therefore, no options are 
available. 

Range On is not supported in Trim Mode. 

All Layers On is not supported in Trim Mode. 

Razor On is not supported in Trim Mode. 

Slip Edit Mode 
Slip mode moves clips to a new time location. Slipping the head moves the head of a clip to the 
cursor while maintaining the position of the tail. Slipping the tail moves the tail of a clip to the 
cursor while maintaining the position of the head. 

Slip is accessed on the same Binnacle key as Trim. Press it once for Trim, twice for Slip. You can 
also swap between the two modes using soft keys. 

Slip Clip 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Trim key on the Binnacle (if not already on) then press it again so that Slip 
lights up. 

Step 3 Press the Clip key 

Step 4 Jog or play the transport 

Step 5 Press Enter – the clip is moved by the amount you just moved the transport. 

Two Handed Slipping 

This is a more powerful method, which is worth learning. 

Step 1 Select a track and move a clip under the cursor. 
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Step 2 Press the Trim key on the Binnacle (if not already on) then press it again so that Slip 
lights up. 

Step 3 Press the Clip key (and hold it down) 

Step 4 Jog or play the transport  

Step 5 Release the Clip key – the clip is moved by the amount you just moved the transport. 

Head 
Can be used one-handed or two-handed. 

The result (when Enter is pressed or the Head key released) is that the Head of the clip is 
slipped to the cursor position, while the Tail position is preserved. The clip gets shorter or longer, 
and the sync moves by the difference in position between the Head before and after the edit. 

Cursor

Before

After

 

Tail 
Same as Head, but the tail is slipped to the cursor position. 

Range 
Ranges cannot be used with Slip. 

Multiple Tracks 
Works as expected. All the red clips will be slipped by the same amount. 

Soft Keys in Slip Mode 

{sync point} Pressing the Slip Sync soft key allows the audio within the clip to be 
slipped, without changing the positions of the head and tail. 
To do this, press the Slip Sync soft key, move the transport, and press 
ENTER. The audio within the clip will move by the amount you just moved 
the transport. 
There are limits to slipping sync. Eventually the end of the recorded audio 
reaches the end of the clip, and after that it can go no further. 

Slip Edit Options 
Trim is usually applied to a single clip or selections across tracks therefore, no options are 
available. 

Range On is not supported in Slip Mode. 
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All Layers On is not supported in Slip Mode. 

Razor On is not supported in Slip Mode. 

Nudge 
Although not a Binnacle editing function, the Nudge function is closely related to Slip. The 
Nudge function slips clips by a predetermined amount of time. Nudge can operate on one or 
many tracks affecting clips that lie under the cursor, or within a Range. Nudge can operate in 
fixed steps of plus or minus one frame, or in {Variable} steps from 1 to 99 sub-frames (a sub-
frame is 1/80th of a frame). The Nudge key is located to the left of the LCD display. 

Using Nudge 

Step 1 Press the Nudge key, to the left of the LCD. 

Step 2 Locate the cursor over the clips and select the appropriate track(s). 

Step 3 Press the {- var}, {+ var}, {- 1 fr} or {+ 1 fr} soft keys to slip the clip(s) by the 
selected amount.  

When there is no Range, only the top layer of clips highlighted under the cursor is 
nudged. 

The {- var} and {- var} keys move selected clips by an amount controlled by the 
{Variable} soft key. It is usually set to a small amount e.g. a few subframes, for very 
fine control of clip position. 

Nudge with A Range 
Follow these steps to perform a NUDGE with a range selected: 
  

Step 1 Press the Nudge key, to the left of the LCD. 

Step 2 Use the From and To keys to select a Range that includes all clips to be nudged. 

Step 3 Press the {- var} {+ var} {- 1 fr} {+ 1 fr} soft keys to slip the clip(s) by the 
selected amount.  

When a Range is selected, all layers of clips within the Range are nudged, including 
those which are completely buried. 

NOTES: 

Nudging is possible while the transport is in play. 

When nudging a Range, clips not wholly within the Range are not affected. However, the Range 
itself is also nudged, so it is possible to keep nudging the Range without resetting the From and 
To points. This can be used, for example, to “phase” the audio with a guide track, using Variable 
nudge with a small value. 
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Fade Mode 
The Fade key on the Binnacle allows fades to be applied non-destructively to the heads and tails 
of clips. The fades are performed by the system in real time as the audio is output from the 
machine. Fades can be created “on the fly” relative to the playhead, or they can be created 
and/or modified on multiple clips at once. 

Fades are applied from the Binnacle Keys, Soft keys, and from the PC screen. 

 

The Editing screen displays fade information in the Smart Pane at the top of the monitor. This is 
used to issue commands as well as illustrate fade shapes (curves). 

Using Binnacle Keys 

Fade Head 

One of the simplest fades can be achieved as follows: 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Binnacle Fade button (if not already on). 

Step 3 Press the Head button. 

This creates a fade from the start of the clip to the cursor position. The shape of the fade can be 
seen above (this will be described later), but the Duration is not used. Instead, the duration is set 
by the cursor position. 

If you are happy with your current fade shape, using Fade Head is a fast and simple way to get a 
lot of work done. 

NOTES:  

• If you do not want to apply the Smart Panel shape shown above to the Head, turn off 
the {shape} soft key. 

• If you ONLY want to apply the shape, and not to change the length of the head fade, 
turn off the {length} soft key. 

Fade Tail 

Same as Fade Head, but it fades from the cursor to the end of the clip. 

Fade Clip 

Applies the numbers in the Head Duration and Tail Duration fields, shown in the Smart Pane. 
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Using Multiple Tracks 

If multiple tracks are selected, the simple Fade Head and Fade Tail commands will apply to all 
clips touching the cursor on selected tracks. 

Using a Range 

If a Range is present, the Fade Head command applies the Head Duration field value, and the 
Fade Tail command applies the Tail Duration field value, to all red clips (those wholly inside the 
range on selected tracks). 

Using Soft Keys 
Advanced fade editing can easily be performed using the soft keys. 

Setting Fade Duration 

Fade duration can be set numerically as follows: 

Step 1 Press the {set dur} soft key. Turn off the {shape} soft key if you do not wish to apply 
the Smart Panel fade shape to the selected clips. 

Step 2 Press the Binnacle Head, Tail  or Clip key. This determines whether the duration you 
set will apply to the head, the tail or both. 

Step 3 Set the Duration value using the Jogger Wheel (press Stop if it is jogging the transport), 
by typing numbers in the Numeric keypad, or using the QWERTY keyboard. 

Step 4 Press the Enter key to apply the fade duration(s). 

Trimming Fade Duration 

Fade durations can be trimmed from their current values. This is particularly useful because it 
can be applied to a range of clips with one command. 

Step 1 Press the {trim dur} soft key. Turn off the {shape} soft key if you do not wish to apply 
the Smart Panel fade shape to the selected clips. 

Step 2 Press the Binnacle Head, Tail  or Clip key. This determines whether the duration you 
trim will apply to the head, the tail or both. 

Step 3 Set the Trim value using the Jogger Wheel (press Stop if it is jogging the transport), by 
typing numbers in the Numeric keypad, or using the QWERTY keyboard. Trim values can 
be positive or negative. 

Step 4 Press the Enter key to apply the fade duration(s). 
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NOTE: Trim values can be positive or negative. To type in a value like minus twelve frames, you 
can use the Numeric Keypad – type Minus, then 12 (or the other way round) then press Enter. 
Using the QWERTY keyboard, you can use the Down Arrow to go from zero to -1 frame, then 
type in a value to be used negatively. 

Fade Shape 

A fade’s shape includes the following parameters: 

X-Point – this controls the percentage of the fade’s duration when it reaches the Crossover Point. 

X-Level – controls how loud the fade is (compared to the full Level of the clip) at the Crossover 
point. 

Duration – the total length of the fade, in frames. (Duration is not really part of the shape, but its 
control is close by). 

Example: Percentage = 30%, Attenuation = -3 dB, Duration = 20 

This means that the fade will last for 20 frames. The crossover point will be 6 frames into the 
fade, at which time the level will be -3 dB compared with full Level. 

Adjusting Fade Shape 

To adjust the fade shape of the currently selected clip(s): 

Step 1 Press the {X-Level} soft key or the {X-Point} soft key  

Step 2 Press the Binnacle Head, Tail  or Clip key to choose which end(s) of the clip you wish 
to change.  

Step 3 Use the jogger wheel to adjust the X-Level or X-Point.  

You can see the change in the shape, as well as the value you are jogging, by looking at 
the Fade Panel in the upper part of the Editing Screen. 

 

You can also type values into the X-Level or X-Point field using the Numeric Keypad or 
the QWERTY key numbers. Always start with a minus when typing X-Level values, as 
they are always negative. 

Step 2 Turn off the {length} soft key if you do not wish to apply the Smart Panel fade 
durations to the selected clips.  

Step 3 Press the Binnacle Enter key to apply the fade shape as specified. 
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Capturing Fade Shapes 

To capture a fade means to extract all of its parameters, making them available to apply to other 
clips. 

Step 1 Press the {capture} soft key. This will cause the Binnacle Clip, Head or Tail key to 
flash, inviting you to select one of them. 

Step 2 Select one of the Binnacle Clip, Head or Tail key to capture the fade length and shape 
from the current clip. The current clip is the clip currently touching the play head on the 
active track.  

Having captured those values, you can apply them to any other red clip by pressing the Clip key. 
Turn off shape or length if you don’t want to apply it. 

Deleting Fades 

Step 1 Press the {delete} soft key, then press the Binnacle Clip, Head or Tail key to delete 
fades. Pressing the Clip key affects fades at both the Head and Tail of each selected 
(red) clip, while pressing Head affects only fades at the head and Tail affects only fades 
at the tail. 

Presets 

Presets are used to save fade shapes only, not lengths. The system provides a number of Fade 
Presets, and you can also save your own Custom presets. 

To recall a system preset: 

Step 1 Press the {Preset} soft key, then press keys 1-9 on the numeric keypad to choose one 
of the 9 factory fade presets. 

Step 2 To apply the recalled shape to a clip, turn off the {length} soft key and press the Clip, 
Head or Tail key, depending which part(s) you wish to apply. 

To recall a custom preset: 

Step 1 Press the {Preset} soft key, then press the {custom preset} soft key, then use the 
jogger wheel to scroll through the list of custom presets. 

Each of the custom presets (if any exist) will be shown in turn, and its shape displayed in 
the Fade panel. 

Stop scrolling when you have loaded the preset you want. 

To save the current shape to a new custom preset: 

Step 1 Press the {Preset} soft key, then press the {save preset} soft key. 

Step 2 Type a name for the new custom preset, then press the Enter key on your console (not 
on the QWERTY keyboard). 

To change the shape stored in a custom preset: 

Step 1 Recall the custom preset as described above. 
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Step 2 Adjust the shape at the head or tail of the clip, or capture new ones from a clip. 

Step 3 Press the {Preset} soft key, then press the {save preset} soft key. 

Step 4 Now immediately press the Binnacle Enter key to save the current values over the 
selected preset. This will overwrite the preset, and the software will give no warning. 

Using the Mouse and Screen 
While the Fade mode is active, the screen displays shapes and controls for creating and editing 
fades. 

 

Fade Head 

Step 1 Select a track and move a clip under the cursor. 

Step 2 Press the Binnacle Fade button (if not already on). 

Step 3 Click the Head button in the screen display (it’s near the upper right). 

Step 4 Adjust the shape of the Head fade (described below). 

Step 5 Click the Apply button. The fade described in the shape is applied to the head of the clip.  

Note that the fade duration is set by the cursor position, as when using the Binnacle keys. 

Length and Shape 

The Length and Shape tickboxes allow you to choose what to apply. You can untick the Length 
tickbox if you only want to apply the shape, and vice versa. 

Fade Shape 

Using the mouse and screen method allows you to set the fade shape before applying it. The 
shape includes the following parameters: 

Percentage (X-Point) – this controls the percentage of the fade’s duration when it reaches the 
Crossover Point. 

Attenuation (X-Level) – controls how loud the fade is (compared to the full Level of the clip) at 
the Crossover point. 

Duration – the total length of the fade, in frames. (Duration is not really part of the shape, but its 
control is close by). 

Example: Percentage = 30%, Attenuation = -3 dB, Duration = 20 

This means that the fade will last for 20 frames. The crossover point will be 6 frames into the 
fade, at which time the level will be -3 dB compared with full Level. 
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NOTE: The fade shape can be changed directly with the mouse, by dragging on the red buttons 
in the graphs. 

Fade Tail 

Same as Fade Head, but the fade is applied to the end of the clip. 

Fade Clip 

If both Head and Tail are selected when you click Apply, both ends of the clip can be faded at 
the same time. 

Using a Range 
If a range is present when the Apply key is clicked, all clips that are wholly inside the range will 
be affected by it. 

Fade Presets 
The system provides nine convenient fade shapes as presets. These can be recalled instantly by 
clicking on the keypad at the left. Having recalled a preset, it can be applied to the Head and/or 
Tail of the currently selected clips using the Apply button.  

Presets 

A preset is a saved shape for head and tail. Factory presets are provided for your use. Custom 
presets are saved by you. 

To load a factory preset, press the {Preset} soft key, then press keys 1-9 on the numeric 
keypad to choose one of the 9 factory fade presets. The preset is loaded into the Shape graphs, 
and can be applied to clips in the usual way. Alternatively, click a number in the preset pad at the 
left of the display. 

 

To load a custom preset: 

Step 1 Press the {preset} soft key 

Step 2 Press {custom preset}. 

Step 3 Turn the Jogger Wheel, and as each custom preset is displayed it is also loaded. Stop 
when you have loaded the one you want. 

Alternatively use the custom presets pulldown menu in the Fades display. 

Click to load a factory preset 
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To save a custom preset: 

Step 1 Set up the fade shapes you want to save. 

Step 2 Press the {preset} soft key 

Step 3 Press {save preset}. 

Step 4 Type a name for the new custom preset and press the Binnacle Enter key. 

Alternatively use the custom presets pulldown menu in the Fades display, as shown 
above. 

Capturing Shapes 
To capture a fade means to extract all of its parameters, making them available to apply to other 
clips. 

Step 1 Click the capture button. This will cause it to flash. 

Step 2 Click the Clip, Head or Tail button to capture the fade length and shape from the current 
clip. The current clip is the one currently touching the play head on the active track.  

Having captured those values, you can apply them to any other red clip by clicking the Clip 
button. Untick shape or length if you don’t want to apply it. 

Cross-Fades 
If a fade is placed on a clip and there is another clip layered underneath, a cross-fade between 
the two will automatically be “induced”. Cross-fade parameters can be modified with the soft key 
menu functions. 

Induced crossfades are complementary – that is to say, the clip underneath is faded with exactly 
the opposite shape to the clip on top. 

If the clip underneath already has its own fade, overlapping the time of the upper clip’s 
crossfade, then no induced fade occurs. In the following illustration, clip layering has been turned 
on (using BLUE Track or View>Display Layering). 

Click to load a custom preset 

Click to type a new name for a 
custom preset, then click Save 
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Induced crossfade – note lower curve No induced fade – lower fade overlaps 

Fade Options 

Layers On 

ALL LAYERS ON is not supported in Fade Mode. 

Razor On 

RAZOR ON is not supported in Fade Mode. 

Soft Edit 
Every clip has a small fade at the head or tail to make it sound smoother. This is called a Soft 
Edit, and you can control its length. To do this, click the Setup Menu on the Track screen and 
select General Preferences. In the dialog that is displayed, click the Playback tab. 

Step 1 Click the Setup Menu on the Track screen 

Step 2 Select General Preferences. 

Step 3 Click the Playback tab. 

Step 4 Change the value for Soft Edits 

The current value for Soft edits is shown in the Audio Options group. A value of 72 samples is 
generally useful when the Project sample rate is 48 kHz, but you may set this according to your 
own taste. 

Creating Smooth Level Changes 
By pasting a copy of a section of a clip onto itself, you are able to change the level of the copy to 
create a level change. If the copy is cross-faded with the original, a smooth level transition 
results. When using the COPY and PASTE functions, be sure to be in STOP otherwise a slight 
movement of the jogger wheel may result in phasing during the fades. 

The same technique can be used to fade one clip EQ setting to another, within the same piece of 
audio. 
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In the above illustration, the top layer plays the same audio as the bottom layer, but may have 
different level or EQ settings. During the fade-in and fade-out, the settings will effectively 
crossfade. 

Gating Clips 
A rough but useful and quick way to remove unwanted silence or near silence from clips is with 
the Gate Clips function. 

Using the Gate Clips Function 
First you will need to select the track(s) using the track feed keys and select the clip(s) either by 
selecting a range or by parking the playback head over the desired clips. You are now ready to 
perform the Gate Clips function. To do this: 

Step 1 Navigate to the Process menu and select Gate Threshold Preview. 

Step 2 Your selected clips will now be shaded in grey. The grey areas mark the audio that will 
be retained after the Gate Clips operation is performed. Start by moving the “Threshold” 
slider slowly to the right. 

Step 3 Depending on the type of audio contained in the clip, areas will begin to be shaded in 
pink. This indicates the areas that will be removed when the Gate Clips function is 
performed. 

Step 4 Once you have adjusted the threshold so that the undesired portions of the clip are 
highlighted in pink, adjust the hold time and pre handle time to fine tune the gating 
process(see below).  

 

Threshold defines when the gate 
“opens” to preserve audio in clip 

Grey indicates “open” gate
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Step 5 When you are happy with the amount retained versus the amount removed from the 
graphic representation, press the “Apply” button to process your settings. All pink areas 
in the clip will be removed, retaining the grey areas. 

NOTE: As with many other editing functions in Dream II, the original audio is not affected by 
clip gating, only the clips that reference it. Any audio removed by gating can be 
recovered using the Trim function (see Trim Function, under the chapter on Editing). 

Mouse-Based Editing 
The mouse can be used to select clips, make ranges and move clips in time and across tracks. 
This can be done irrespective of which editing or mixing mode is selected. 

Selecting Clips 
As explained previously, the mouse can be used to select and deselect individual clips within the 
range, by Ctrl-clicking on them. If no range is present this can still be done. When you Ctrl-click a 
clip when no range is present, a range will be created which includes all the previously selected 
clips, plus the one just added. If the track containing the clip was not selected, it becomes 
selected automatically. 

Mouse-Based Ranges 
The mouse can be used at any time to create a range. Simply click an empty space (one where 
there is no clip) and drag an area on the Track display, and a range will be created. 

At the same time, any clips or parts of clips on already selected tracks, that are inside the 
area you dragged, will be selected. All other clips will be deselected. 

Selecting clips when creating a range with the mouse does not select tracks, but selecting clips 
by directly Ctrl-clicking them does select tracks. 

To remove the current range, click (but don’t drag) anywhere with the mouse. 

Moving Clips 
Clips can be dragged horizontally and vertically with the mouse. This changes the clip timecode 
and track respectively. 

Hold defines how long Gate 
remains open after audio level falls 
below set threshold value 

Notice length of “Hold” 

Handle defines time gate opens 
before threshold is reached 

Notice gate open duration 
before threshold is reached 
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When there is no range, simply click and drag any single clip to another time or track. 

When there is a range, click on any selected (red) clip and drag it – all other red clips will also be 
dragged along with the one you clicked. 

Summary of Mouse Editing Actions 

Action Result 

Click on unused trackspace Removes range 

Ctrl-Click on a clip If unselected, adds it to the selection (makes it 
red). Also selects its track, if not already selected. 
If already selected, removes it from the selection 
(makes it blue) 

With no range, click on a clip and drag it The clip moves to any track and time where you 
drag it 

With a range, click on a selected clip 
and drag it 

All selected clips move across tracks and time as 
you drag them. 

Display Layering 
When clips are placed “on top” of each other, only the uppermost is heard, or at most a 
crossfade between the top and second layers. The software allows you to see all the layers by 
selecting Display Layering using BLUE+Takes or via the onscreen View menu. 

 

The layers of clips are shown on all tracks, with the clips becoming thinner as needed to fit the 
available space. 
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The mouse can be used to change the order of clips. To do this, simply click and drag a clip from 
one level to a higher or lower level. Changing levels in this way can be combined with dragging a 
clip to a different track or timecode. 

Note that there is always a space at the top of each track, equal to the width of one clip. This is 
to allow room for you to drag a clip into the top position. 

Mouse Edit Menu 
The screen Edit Menu provides many commands that are available elsewhere in the system. The 
mouse can be used to access these commands. 
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Cuts the selected clip or range to the clipboard 

Cuts the head of the clip at the cursor position 

Cuts the tail of the clip at the cursor position 

Copies the selected clip or range to the clipboard 

Copies the head of the clip at the cursor position 

Copies the tail of the clip at the cursor position 

Pastes a copy of the clipboard at the current position 

Erases the selected clip or range 

Erases the head of the clip at the cursor position 

Erases the tail of the clip at the cursor position 

Extends the clip head to use all the recorded audio 

Extends the clip tail to use all the recorded audio 

Cuts the selected clips into two at the cursor 

Allows the level of selected clips to be set 

Allows the selected clips to be renamed 

Syncs the selected clips to their record timecode 

Reverses the audio in the clips 

Cycles clip layers around when in BLUE Takes mode 

Positions the Sync point in the clip. Can be used for Jumping 

Undoes the last edit 

Redoes the last edit that was undone 

Shows a list of the edits that can be undone 

Fade to the nearest end  

Fades from the head to the cursor 

Fades from the cursor to the tail 

Controls the number of layers affected by edits 

Controls Range On/Off and sets head and tail of range. 
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Chapter 9 -  Grouping 

Introduction 
Grouping is a fast and convenient method of controlling more than one signal path from a single 
fader or parameter control. There are two types of groups: Link Groups and MultiTrim Groups. 

Link groups are designed for controlling groups of feeds in multichannel formats. Link groups 
simplify many tasks associated with working in surround formats and share many of the 
operational features of surround format buses. Link groups can include up to eight members. The 
simplest link group has two members and fulfils the function of a stereo channel. 

MultiTrim Groups allow a number of tracks and/or Live Feeds to be selected and controlled with a 
single screen fader, mute button, EQ In/Out switch and so on. 

Summary of Groups 
Type Member Type Master Fader Selection to 

Fat Channel 
Stem Structure 

Link Group Live Feed or 
Track Feed 

Link Group 
Master - level 
equal to first 
member. 

Select any 
member 

Yes 

MultiTrim 
Group 

Live Feed or 
Track Feed 

Any group 
member 

No No 

Link Groups 
Link groups allow the control of up to eight feeds with one fader. Link groups can only include 
track feeds or live feeds, not a mixture of both. Link groups can be created in any standard 
multichannel format. 

Link Group Features 
Linking feeds in link groups has the following effects: 

1. Selecting one member selects the entire link group. 

2. The master fader is the one controlling the lowest numbered channel in the group. When 
the group is created, the group master fader adopts the level of that channel. When its 
fader is adjusted, the member’s fader levels are set to the same level. This is also true of 
the Mute, Solo, EQ In/Out button and Insert In/Out button. 

3. It is possible to control the individual members’ independently. This applies only to the 
controls shown in the channel tile i.e. Fader, Mute, Solo, EQ In/Out button and Insert 
In/Out. But whatever these settings are, they will be overridden by any change to the 
Master tile. 

4. When a group is created the master pan control is centred. The Spread and Rotate 
controls become active when the link group master is called to the Fat Channel. These 
pan parameters offer unique and flexible panning controls to multichannel link groups. 
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5. When the group is created, the In-Line Panel and Channel Panel controls adopt the 
position of the first feed in the group. When a rotary control is adjusted, the controls of 
the members are offset by the amount the master control is moved. Switch controlled 
parameters display the current setting of the first member in the group. Pressing a 
switch with a toggled value will set all members off. Double pressing will set all member 
parameters on. For switches which cycle through a number of values, pressing the switch 
will set all members to the next value of the Group Master. 

6. The MUTE and SOLO keys on the Master Fader section indicate the mute and solo status 
of all the members. 

7. The AUTO key on the Master Fader section enables automation recording for the link 
group master which will control all the members. 

8. When selected, a link group is displayed in the channel display at the bottom of the 
mixer display. The display shows input patching and destinations for the entire group. 

9. When using dynamics across a link group, the side chain signal for each member is 
derived from the maximum signal level for the entire group thus maintaining the integrity 
of the signal image. 

Creating a Link Group 

Step 1 Press the BLUE-Group Key. 

 

The feeds that currently belong to link groups flash red. Feeds available for selection are 
dimly lit. 

Step 2 Press the feed selection key of the first feed of the group. Its key lights up, and so do 
the keys of the next seven feeds, which are the other possible members of the new link 
group. 

Step 3 Press one of the illuminated feed selection keys to make it the last feed of the group. 

Link groups can only include track feeds or live feeds, not a mixture of both. Link groups 
can only include up to eight members, which must have contiguous number e.g. 3 to 10. 
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Step 4 Select a menu item from the {Apply Defaults} soft key menu. 

{all defaults} applies pan settings to each member to set the link group into a surround 
format as described below under “Link Group Format”. All defaults also 
applies the mix parameter values of the first member to all the members. 
Parameters modified are fader level, pan, EQ, dynamics, aux sends, 
inserts and direct out state. 

{default pans} applies pan settings to each member to set the link group into a surround 
format as described below under “Link Group Format”. Default pans 
affects the pan parameter only.  

{feed params} applies the mix parameter values of the first member to all members, 
excluding pan. Parameters modified are fader level, EQ, dynamics, aux 
sends, inserts and direct outs. 

{no defaults}  no feed parameters are modified. 

Step 5 Press another mode key to continue mixing or editing. 

The link group is displayed in the channel display at the bottom of the mixer display. If 
composed of Track Feeds, it is also shown in the Editing Screen. 

     

You can collapse the linked tracks down to the width of one track by double-clicking any 
of the linked tracks, close to its left side. Do the same thing to expand them. 

Link Group Format 
When a link group is created with default pans selected, the number of members determines the 
format of the link group. When a link group is created, you have the option of retaining the 
current pan setting of each member or using default pan settings for the chosen format.  

Double-click 
here to collapse 
or expand the 
linked tracks. 
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If default pans are selected each member of the group is panned to one element of the bus in 
the following order: 

If 2 Feeds are linked, they are panned L R. 

If 3 Feeds are linked they are panned L C R. 

If 4 Feeds are linked they are panned L C R S. 

If 5 Feeds are linked they are panned L C R LS RS. 

If 6 Feeds are linked they are panned L C R LS RS B. 

If 7 Feeds are linked they are panned L C R LS CS RS B. 

If 8 Feeds are linked they are panned L LC C RC R LS RS B 

Normally each member is panned hard to one Bus Element position, spread is set to maximum, 
divergence is set to minimum and rotation is set to zero.  

If you are using a link group to control a premixed stem which is delivered in a different channel 
order, it may be necessary to edit the track order on the disk recorder or to change the input 
patching of the feeds if the stem is played in off an external device. 

Destroying a Link Group 
Link groups are destroyed from the Link Group menu: 

Step 1 Press BLUE-Group. 

The feeds that currently belong to link groups flash red.  

Step 2 Press the feed selection key of a feed belonging to a group. 

Step 3 Select {unlink} on the LCD soft key menu item.  

Press another key to continue mixing or editing. 

The MultiTrim Group 
The system supports a single MultiTrim group. When channels are members of the group, their 
fader levels, Mutes, Solos, EQ In/Out and Insert In/Out can be controlled from any member of 
the group.  

To add/remove Tracks and Live Feeds from the MultiTrim group:  

Step 1 Click on the number of the feed, in the mixer screen. 

Members of the MultiTrim group are shown with red numbers, as shown below. 
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Operations with a MultiTrim group include the following: 

1. Click and drag any member’s fader to move all the group’s faders relatively (in proportion 
to their current value). 

2. Ctrl-Click and drag any member’s fader to move all the group’s faders absolutely (they 
are all set to the same value). 

3. Click any toggle switch on any member’s tile (Mute, Solo, EQ In/Out, Insert In/Out) to 
toggle all members’ switches. 

4. Ctrl-Click any toggle switch on any member’s tile (Mute, Solo, EQ In/Out, Insert In/Out) 
to set the value of that toggle to be the same for all members. 

Link Groups can be included in the MultiTrim group. When any of the MultiTrim members’ faders 
are moved, the whole Link Group adopts the fader value of the first member, removing any 
offsets between them that might have existed earlier. 

To clear the MultiTrim Group, double click on one of the red channel numbers  

Naming a Link Group 
Link groups are named using the Call Menu.  

Step 1 Press the Call key  

Step 2 Select any member of the Link group 

Step 3 Press the {name} soft key in the Call menu. 

The LCD will show the current name of the Link Group. It will initially  have the name of 

MultiTrim group 
members 
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its first member.  

Step 4 Press the Del key in the QWERTY keyboard. This will remove the current name. 

Step 5 Type a new name and press Enter. 
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Chapter 10 – Mixing 

All Satellite mixing functions use the mouse.  

Mixer Screen 

 

Tiles 
A Tile shows basic information about the Feed it represents. 

Bus tiles show only fader information. Track Feed and Live Feed tiles display more information, and 
provide control for a group of functions, as shown below. 

Live Feed tiles 

Track Feed tiles “Called” channel 

Sub-bus tiles Aux bus tiles  Main bus Automation 

Fat Channel 
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Called Channel 
One channel can be controlled in detail. It is the “Called” channel. In the picture above, it is Track 6. 

To call a channel from the mixer screen, simply click on its tile, or operate any of the controls inside it. 

You can also call a channel using the CALL menu. 

Track Feed and Live Feed Channel Tiles 
Each Track and Live Feed is represented with the track name and fader level, plus indicators for EQ, 
dynamics, insert, solo, solo defeat, and mute. 

The parameter window within each channel tile provides a condensed display of the current settings of 
the Channel Panel for EQ, dynamics or pan. 

• EQ – a graph displays the EQ transfer response. 

 

• Dynamics - a simplified transfer function for compressor, limiter, expander, gate, and the various 
combinations of these can be displayed. 

 

• Pan - a miniature display of the pan surround field with the red pan position is displayed. The pan 
position changes in real time. 

Fader Control 

Solo ON / OFF 

EQ IN / OUT 

Insert IN / OUT 

Mute ON / OFF 

Dynamics In (indicator only – appears 
when any dynamics present) Click here to 

cycle the 
display 
between Pan, 
EQ and Dyn 

Click here to 
add this channel 
to the Multi-
Trim group (the 
number goes 
red) 
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Buses 

The fader levels of the Main, sub and auxiliary buses are displayed. Signal level meters for the Main bus 
are also displayed. 

Fat Channel 
The Fat Channel provides a detailed display of the signal processing and routing for the called channel. 
Its only control function is the fader, while the other graphics are for display only. 

 

Right clicking in the EQ, DYN or PAN sections causes display of the Zoom panels. See below. 

The Fat Channel shows a detailed display of the parameters for the currently called signal path. A signal 
path may be a mono live or track feed, a bus or a multichannel surround format link group which can be 
selected and modified from a single set of controls. 

• The user and system names of the signal path are displayed at the top left. The input box at the 
left of the signal path, indicates the format or element name of the path and the user name and 
system name of the physical input from which it is patched 

• The input meter shows the signal level at the input of the signal path.  

• If a track feed is selected, the input fader level is shown.  

• The EQ display shows a graph of the equaliser response.  

• The dynamics display shows the composite transfer function of the entire dynamics section. The 
display also includes gain reduction signal meters for all three sections. If the dynamics are 
switched IN the graph is highlighted, if switched OUT the graph is dimmed. 

• The insert send and receive I/O patching is displayed. If the insert is switched IN the insert 
display is highlighted, if switched OUT the display is dimmed. 

• The main fader level for the signal path is displayed with a numeric display of the fader gain. This 
is an active control. 

• The direct out level, pre/post status and output patching is displayed. If the direct out is switched 
ON the direct out display is highlighted, if switched OFF the display is dimmed. The direct out 
level is shown with a horizontal bar. If the direct out is switched ON the bar is yellow, if switched 
OFF the bar is violet. The section of the bar above 0dB of gain is shown in red. 
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• The Auxiliary bus display shows the status of each aux send. The send level is shown with a 
horizontal bar. If the send is switched ON the bar is yellow, if switched OFF the bar is violet. The 
section of the bar above 0dB of gain is shown in red. 

• The pan display offers a sophisticated representation of the signal path panner. The display 
always shows a 7.1 sound field as the panning information for any path can be applied to any 
format bus to which it is assigned. The red circle indicates the current pan position. If a link 
group has been called, the pan display shows a red circle for the pan position of each member 
and a yellow circle for the position of the virtual link group master. When diverge is applied, a 
white circle represents the perceived image size. 

• When a bus is called, the output box displays the output patching, showing each bus element 
and the user and system names of the physical outputs to which they are connected.  

Virtual Channel 
All other functions can be controlled using the DREAM II Virtual Channel, shown below.  

 

• To open the DREAM II Virtual Channel, right click on a channel “tile” in the Mixing Screen. In the 
above example, we have right clicked Track 8. 

• To close the Virtual Channel, right click anywhere inside it. 

• While it is open, you may move to the next or previous channel by clicking the + and – buttons 
next to the channel name. 

   

Click to select next or 
previous channel 
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Panning 
Dream II supported surround formats are: Stereo; LCRS, LCRSS; 5.1; 6.1; and 7.1.   

 

While operating the pan controls, the Fat Channel gives a visual representation of the pan position and 
divergence. A complex example is shown below. 

 

Basic Panning 

Use the L-R and F-B controls for basic panning. If the Main Bus format does not have surround channels, 
the F-B control will still be shown, but will do nothing. 

Spread 

Only available when a link group is selected.  The spread control adjusts the perceived size of a surround 
mix. 

Diverge 

Spreads the signal of an individual feed across more of the adjacent loudspeakers, making the perceived 
size of the sound source larger. 

Rotate 

Rotate controls the left/right and front/back pan control to rotate the surround mix around the centre of 
the room. 

Using the panner: 

Step 1 Call a signal path to the channel panel by pressing the Call button on any fader.  

Panning IN / OUT 

Boom send ON / 
OFF

Panning of 4-way Link Group 
showing Rotation and 
Divergence 
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Step 2 Adjust the control to achieve the desired result.  The parameter values are displayed in the fat 
channel section at the bottom of the mixer display. 

Boom 

Sending level to the Boom channel can be done pre or post fader. 

Equalisation 

 

The track feed mixer EQ provides four bands of parametric equalization and two filters.  Each parametric 
section can be switched in or out independently. 

The Gain controls in the Filter sections have no function. The 2X controls double the slope of the filters, 
from 12 to 24 dB / octave. 

Parametric EQ 
(bandpass) 

Lo-Pass Filter 

Hi-Pass Filter 

EQ IN / OUT 

Gain Compensation 

Hi Shelf 

Lo Shelf 
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Dynamics 
The Dream II Dynamics comprises three sections, compressor, limiter, and expander or gate. 

 

Each section has an independent IN / OUT control. All three may be active at the same time if required. 

The Fat Channel shows the transfer function of the dynamics control, plus gain reduction metering. 

Make-up gain 

Limiter IN / OUT 

Gate/Expander IN / OUT 

Compressor IN / OUT 
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Aux Sends 
Satellite-AV provides 12 aux sends. Each send from each channel has an independent Pre/Post switch 
and In/Out control. 

 

Zoom Panels 
It is possible to see more detail when adjusting EQ, Dynamics and Pan control, using Zoom Panels. In 
particular, numeric values for all parameters are shown, and update as they are changed. 

To display a zoom panel, right click in the corresponding display in the Fat Channel. 

Aux 2 send IN / OUT 
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Right-Click here to display Zoom panels 

The Equalizer Panel 

 

The Dynamics Panel 
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The Pan Panel 
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Chapter 11 -  Automation 

Introduction 
The Constellation automation system provides simple, flexible and comprehensive facilities for recording 
and editing mix automation data. All feed and bus mix parameters can be automated and played back in 
perfect synchronisation with the project audio. In addition to the channel parameters, bus assignments, 
inserts and direct outs may also be recorded. 

The Constellation automation system is designed to allow the operator to record all the static and 
dynamic parameter changes involved in balancing the mix of tracks played back from the disk recorder 
and live feeds from external sources. Mix moves may be recorded on one or more parameters or 
channels at a time. More moves may be added with each pass, resulting in complex and detailed mixes 
that can be played back identically every time the project and mix are loaded. 

Automation Basics 

Write, Trim and Read 
In Automation, we use the terms Write, Trim and Read. 

• Write means to record absolute values of parameters. 

• Trim means to record changes to stored values of parameters. 

• Read means to play back the parameter values that have been written. 

The word “record” is used in this chapter to mean “Write or Trim”. 

The Mix Item 
A mix item is one parameter for one signal path. Examples are: 

Track 47  –  Main Bus Fader Level 

Live 11  –  EQ Band 1 Q-factor 

Sub Bus 2 –  Mute 

There are literally thousands of mix items in the Satellite-AV system. The automation system can write 
the changing values or states of every mix item over the duration of your project, and read it starting at 
any position. These written values and states are called mix automation data. 

Automation Enable 
When the Automation Enable checkbox is OFF, all mixing and routing functions are manually operated 
and the mixer will not write or read automation. 

When the Automation Enable checkbox is ON, all mix items for which automation data is written will 
read that data, and the user has no manual control of them. Mix items with no written automation data 
can be manually controlled by the user. 

Mix Duration 
The automation data for a project starts at a timecode location one frame after timecode midnight and 
finishes one frame before midnight. However, the system requires a minimum preroll of at least one 
second and it is advisable to start projects at a location of at least one minute after midnight to provide 
adequate preroll. 
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Project Snapshot 
Every project contains a snapshot of the state of the mixer when the project was last closed. When a 
project is opened, the mixer state is updated and all parameters are recalled. 

Mix Snapshot 
Every saved mix contains a snapshot of the state of the mixer when the mix was saved. When a mix is 
loaded the mixer state is updated and all mix items are recalled. So it is not necessary to write 
automation data for items that do not change during the project – they will be reset to their correct static 
values when the mix is loaded. 

Mix Controls 

 

Automation control is managed from the Automation section of the Mixer Screen, shown above. 

Procedure for Automation 
To automated mixer data, do the following: 

Step 1 Enable Automation 

Click the Enable button at the top of the section 

Step 2 Enable Parameters 

Click any of the buttons in the Enables section. Only the enabled parameters will write data. In 
the above picture, Faders are enabled. 

Fader in WRITE 

Faders in READ 



Satellite-AV User Manual CHAPTER 11 - AUTOMATION  

Satellite-AV Page 105 

Step 3a Enable Signal Paths – Method 1 

Set Touch to either Latch or Snap 

Select the Mix menu button on the Satellite console, and select a track to automate. When you 
touch that Track’s controls, it will go into write (or trim) 

Step 3a Enable Signal Paths – Method 2 

Set Touch to either Latch or Snap 

Switch on Touch Auto Enable, using its checkbox 

When you touch the controls on any signal path, it will go into write (or trim) 

Step 4 On Stop Setting 

This can be set on the screen or using the On Stop soft key in the Mix Menu. 

If {On Stop Hold} is selected, all the following mix events are deleted, so the last written value 
remains in force for the rest of the project. 

If {On Stop Return} is selected, the parameter ramps to the previously recorded value over the 
Glide Out time (Glide Out time is set in the Utils Menu). 

If {On Stop Event} is selected, the last written value remains in force until a previously 
recorded event is encountered. At this point the parameter value ramps to the new value over 
the Glide Out time. 

Step 5 Record Setting 

Select WRITE or TRIM 

WRITE: New values are written for enabled parameters, replacing the previous values. 

TRIM: In trim mode, moving a control applies an offset to the values already recorded for that 
mix item. For example, in trim mode, increasing a fader level by 10dB will add 10dB to the 
previously recorded fader levels retaining all the relative changes in the previously recorded data.  

Step 6 Put the transport into Play (or Record) 

Step 7 Move the enabled controls. Stop to cease recording automation data. 

The data will be written to the automation file. When you play back over this section, the moves 
you made will be shown in the controls. 

Mix Events 
Mix data is recorded as discrete events. Each event occurs at a specific timecode location and relates to a 
specific mix item. When a new mix is started there are no events recorded and all controls will remain 
static as the project is played. Once mix data is recorded, it is played back or read when the transport 
runs past the timecode at which the event is recorded. If the transport is located to any point in the 
project, the mixer state will reflect the result of all the events that have occurred from the start of the 
project to the current timecode. 

The static snapshot recorded with every mix preserves the basic setup and balance of the mix. Dynamic 
move events are added to this to create the final complete mix. 
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Transitions – Using Glide 
When the automation system makes a transition from Write or Trim to Read, Glide out data will be 
written to smooth the parameter transition as described below. The Glide Out transition starts at the 
point where the system leaves record and finishes at the Out point plus the Glide Out time. 

Glide times are set in the Utils menu. 

Automation Playback 
The DREAM II automation system ensures that your mix will always play back exactly as recorded. There 
are two main forms of automation data recorded in a project. The first is the static snapshot of all 
parameters which is recorded whenever a mix is saved. The second type of data are the dynamic auto-
mation events that are recorded every time a parameter is modified while the system is writing or 
trimming automation. 

Once a dynamic event has been recorded on a feed or bus, that parameter will be in READ whenever 
Automation is enabled, and the transport is in PLAY. 

When the system detects that a parameter control has changed while in Write or Trim, a dynamic event 
is recorded that stores the previous value and the new value (FROM value and TO value) of that specific 
parameter at a specific timecode location. 

When Automation is enabled and the transport is located to any position on the time line, the automation 
system looks back and forward in time to find any events previously recorded for the parameter. If no 
dynamic events have been recorded for the parameter, the parameter is set to the value recorded in the 
mix snapshot. 

The current value for any parameter is determined in the following order: 

1. The parameter is set to the TO value of the most recent previous event. 

2. If no previous event exists, the parameter is set to the FROM value of the next future event. 

3. If no future or previous event exists, the parameter is set to the value recorded in the mix 
snapshot. 

Saving and Loading Mixes 
Up to 256 complete mixes may be saved in each project and recalled later. Mixes must be saved before 
closing a project, or any unsaved mix data will be lost. The available space left in the project file for new 
mixes or mix data is displayed in the Mix menu. When the space left falls below 2% the Save soft key 
becomes disabled. 

Saving a Mix 

Step 1 Hold down a BLUE key and press the Mix/File key. 

Step 2 Press the Save soft key in the LCD menu. 

Step 3 Type a unique name for the mix on the PC keyboard and press Enter. 

Alternatively, type a name with a numeric suffix, (e.g. Demo Mix 1). The next time you press Save, a new 
name will automatically be generated with an incremented suffix (e.g. Demo Mix 2). Press 
Enter, to save the mix with the new name. 

Loading a Mix 

Step 1 Hold down a BLUE key and press the Mix/File key. 

Step 2 Turn the jog wheel to scroll through the previously saved mixes. 

Press the Sort:  soft key to select TIME or ALPHA. ALPHA sorts the saved mixes in alpha-
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numeric order. TIME sorts the saved mixes in the order in which they were saved, with the most 
recently saved mix at the end of the list. 

Step 3 Press the Load soft key in the LCD menu to load the selected mix. 

Step 4 Confirm by pressing the Yes or No soft key. 

Deleting a Mix 

Step 1 Hold down a BLUE key and press the Mix/File key. 

Step 2 Turn the jog wheel to scroll through the previously saved mixes. 

Step 3 Press the Delete soft key in the LCD menu to delete the selected mix. 

Creating a New Mix 
Follow these steps to create new empty mix with no automation data: 

Step 1 Hold down a BLUE key and press the Mix/File key. 

Step 2 Press the New Mix soft key in the LCD menu. 

This new mix must be saved once new data has been written. 

Copy a Mix Between Projects 
Mix Carry Over allows the static snapshot and dynamic mix data from a single mix to be copied from one 
project to another. 

Step 1 Hold down a BLUE key and press the File key and use the Save or Load soft key to save your 
current mix or load a previously saved mix. 

Step 2 Press the Carry over soft key in the File menu. The Carry over key flashes when carry over is 
active. 

Step 3 Close the current project. 

Step 4 Open the destination project. 

Step 5 Hold down a BLUE key and press File key and use the Save soft key to save the mix in the new 
project. 

Mix Undo 
The automation system supports one level of mix undo.  

Step 1 Hold down a BLUE key and press the Mix/File key. 

Step 2 Press the UNDO PASS soft key in the LCD menu. 

UNDO PASS deletes all mix automation data written between entering PLAY and STOP during the last 
mix pass. UNDO PASS can be used until new automation data is written. If UNDO PASS is pressed during a 
mix pass the soft key flashes to indicate that all data written during that pass will be ignored. 

'System Mix' - Save function 
The 'System Mix' function is available from the FILE menu. When switched on, the current mix pass will 
automatically be saved when the project is closed, and will likewise automatically be loaded when the 
project is opened. 

Step 1 Hold down a BLUE key and press the Mix/File key. 
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Step 2 Press the SYSTEM MIX ON soft key in the LCD menu. 

AutoSave 
Also from the FILE menu, there is an "AutoSave" feature available, with user-definable timing from 5 to 
60 minutes. 

The Mix Menu 
Only mix menu items that are dimly lit are available in DREAM II software release 2.0 

Press the Mix key to display the Mix menu. When the mix menu is active, the feed and bus selection 
keys are used to enable specific paths for automation. The From and To keys can be used to set the In 
and Out points for automation punch In and Out points which are displayed at the left of the LCD. The 
available mix memory is displayed in percent. The current mix name is displayed at the right of the LCD.      
  

all Read All parameters are instantly dropped in to Read. 

On STOP Determines what data is written after leaving automation record by pressing the STOP key or 
pressing the Mix ON. 

Hold - erases all events from the current position to the end of the project. 

Return - returns to the previously recorded value at the current location. 

Event - holds the current value until the next event is encountered. 

Touch Auto Enable  

ON - When a Touch mode is engaged (SNAP or LATCH), any enabled parameters that are 
touched are automatically put into Write or Trim. It is not necessary to first enable the feed or 
bus. 

OFF - When a Touch mode is engaged (SNAP or LATCH), only feeds or buses that have been 
enabled in the mix menu will be put into Write or Trim when their enabled parameters are 
touched. 

Fill Range Used in conjunction with Preview. Causes the current values of previewed parameters to be 
written through the range. 

The Blue Utils Menu 
Glide In When a parameter transitions from one READ value to a new RECORD value discontinuously, as 

when dropping in from PREVIEW to RECORD or when merging one mix into another, this value is 
used to define a ramp from the previous data to the new data. 

Press the Glide In soft key and use the jog wheel, numeric keys or +/- keys and press Enter to 
change the Glide In value.  

Glide Out When a parameter transitions from one RECORD value to a new READ value discontinuously, as 
when dropping out of RECORD or when merging one mix into another, this value is used to 
define a ramp from the previous data to the new data 

Press the Glide Out soft key and use the jog wheel, numeric keys or +/- keys and press Enter to 
change the Glide Out value. 

Update Sys-File 

Saves the following system settings to the following files: 



Satellite-AV User Manual CHAPTER 11 - AUTOMATION  

Satellite-AV Page 109 

Monitor_Sources.TXT - patching and formats of external monitor sources. 

Speaker_Sets.TXT - patching and formats of all speaker sets. 

Setup_Variables.TXT - Call Follow state and Constellation brightness. 

Automation with Link Groups 
Link groups are useful for dealing with groups of feeds carrying audio in a multi-channel format such as 
stereo or 5.1. See “Grouping” on page 86 for an overview of link groups. 

Link groups should be established before any automation is written. If members are added to a group 
when automation data is present on either the master or the members, the data on the members is 
erased. If the link group is destroyed or unlinked after automation is recorded for the group, the au-
tomation data remains on the group master but not the slaves. 

Only the parameters on the link group master can be automated – the slave member’s parameters follow 
the master.  

Mix Editing 

Mix Copy 
Mix Copy allows a selection of automated mix parameters to be copied from one time location to another. 

Step 1 Press the MIX ON key to enable mix automation. 

Step 2 Select the mix items you wish to copy by selecting parameters and signal paths in the usual way. 

Step 3 Use the From and To keys to select the range from which you want to copy, or hold down a 
BLUE key and use the Range automation key to copy the existing editor range. The IN and OUT 
points are displayed on the LCD. 

Step 4 Press the Mix Edit soft key in the Mix menu. 

Step 5 Locate the cursor to the destination where you want to paste the mix automation data. 

Step 6 Press the Copy Mix soft key to perform the mix copy operation. 

Step 7 Press the Back to Mix soft key to return to the Mix menu. 

Data Storage 
All the mix data of the current mix is stored in system memory. This data must be explicitly saved to disk 
as a named mix. If a new project is loaded, the previous mix data is retained in memory and may be 
saved as a mix in the new project. 

Mix "Thinning" 
Constellation offers a Mix "thinning" algorithm that "ignores" identical static mix data, This is especially 
useful for large amounts of mix data as it can largely reduce the actual number of mix events. When 
automation is written, there can be events that are nothing more than a block of "static" information e.g. 
nothing more than an "in and out" point with no "dynamic" information in between. These neutral events 
can nonetheless add up to a lot of data. With Mix Thinning turned on, multiple identical events of this na-
ture are only identified once therefore creating less events data in the global mix. The feature operates 
transparently. 

If desired, this functionality needs to be turned on: 

Instructions: 

Step 1 Hold down a BLUE key and press the Utils key to enter the Utils menu. 
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Step 2 Update your Sys file by pressing the Update Sys File soft key. 

Step 3 Type <Shift-Pause-Q-Y> on the keyboard to quit out of the FMC console software program. 

Step 4 Navigate in Windows to \Fairlight\FMC\Data and open the file System_Variables.TXT 

Step 5 There is a line in that file: 

MIX_THINNING_ENABLED, 0 

Set the 0 to a 1 and save the file.  

Restart the system, and Mix Thinning will be operating. 
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Chapter 12 -  Library 

Introduction 
The Library menu provides storage for Equaliser, Dynamics, Channel presets or complete Satellite-AV 
snap shots. Up to 100 of each type of preset can be stored. These presets can be recalled and applied to 
any signal path in any project. 

 

To access the Library menu, press the Lib key. 

Select the preset type by pressing the {chan EQ}, {chan dyn}, {all chan} or {all console} soft key. 
Select the library function by pressing the {Save}, {Load} or {Delete} keys. The presets and functions 
are described below. {all chan} means all the parameters in the currently selected signal path. 

Presets 

Equaliser 
A library of 100 equaliser settings is provided. Each equaliser preset stores all the parameter settings of 
the equaliser section on the signal path currently called to the Master fader. 

Press the EQ soft key in the Library menu to select equaliser presets. 

Dynamics 
A library of 100 dynamics settings is provided. Each dynamics preset stores all the parameter settings of 
the dynamics section on the signal path currently called to the Master fader. 

Press the DYN soft key in the Library menu to select dynamics presets. 

Channel 
A library of 100 channel settings is provided. Each channel preset stores all the parameter settings on the 
signal path currently called to the Master fader, excluding I/O patching. 

ALL Console 
A library of 100 console settings is provided. Each preset stores all mixer parameters for all feeds and 
buses. All patching, routing and name settings are also stored.  
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Default Satellite-AV Template 

A special console library file named default is used to store the default setup of the Satellite-AV on 
power up. You may overwrite this file with any setup that suits your requirements. 

Saving a Preset 
Follow these steps to save a preset: 

Step 1 Call a signal path to the Master fader by clicking its tile in the Mixer screen, pressing the Call key 
and then clicking one of the feed or bus selection keys, or in any of the other ways. 

Step 2 Adjust the parameters you wish to store. 

Step 3 Press the Lib key to display the library menu. 

Step 4 Press the {chan EQ}, {chan dyn}, {all chan} or {all console} soft key to select the type of 
preset you wish to store. 

Step 5 Press the {Save} soft key and type a new name for the library preset. The name of the last-
saved preset is displayed by default and its settings will be overwritten if you do not change the 
name. 

Step 6 Press Enter to save the preset or press the {Cancel} soft key to cancel the operation. 

Loading a Preset 
Follow these steps to load a preset: 

Step 1 Call the destination signal path to the Master fader. 

Step 2 Press the Lib key to display the library menu. 

Step 3 Press the {chan EQ}, {chan dyn}, {all chan} or {all console} soft key to select the type of 
preset you wish to load. 

Step 4 Turn the jog wheel to scroll through the list of available library presets for the selected type. 

Step 5 Press the {Load} soft key then press the {Yes} soft key to confirm the operation. 

If you choose an {all console} preset, it doesn’t matter which signal path is selected, because 
the whole console will be loaded. 

Deleting a Preset 
Unwanted library presets can be deleted by following these steps: 

Step 6 Press the Lib key to display the library menu. 

Step 7 Press the {chan EQ}, {chan dyn}, {all chan} or {all console} soft key to select the type of 
preset you wish to load. delete. 

Step 8 Turn the jog wheel to scroll through the list of available library presets for the selected type. 

Step 9 Press the {Delete} soft key then press the {Yes} soft key to confirm the operation.
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Chapter 13 -  Name 

Introduction 
The Name Menu allows you to rename tracks and clips, and to setup ‘seed names’ for 
recording. When a name function is selected, the original name appears in a popup window. 
You can then use the BACKSPACE key to delete the original name and supply a new one. 

 
  

Step 1 Press the NAME key. 

Step 2 Select the {clip}, {track} or {record seed} soft key. 

Pressing {clip} allows you to enter a name for the clip under the cursor (the system 
will complain if there isn’t one). 

Pressing {track} allows you to enter a name for the currently selected track. 

Pressing {record seed} allows you to enter the prefix and index number for the next 
recorded clip on the current track. 

Step 3 Edit the name in the popup window that appears on the PC screen. 

Step 4 Press Enter on the QWERTY keyboard, or click OK. 

  

Naming Tracks 
The track names of a Project can be changed to help organise Projects. Select the required 
track and press the {track} soft key in the Name Menu. Enter the new name. 

Naming Clips 
All clips in a Project can be given an individual name. A clip can be copied and given a different 
name to the original. Different clips can also be given the same name. To name a clip, locate 
the transport so the cursor lies over the clip, selecting the appropriate track if necessary, then 
press the CLIP soft key in the Name Menu. Enter the new name using the PC keyboard. 

Alternative – Naming from the PC Edit Screen 
To rename a clip, select the Rename command in the onscreen Edit menu, then type the new 
name for the clip and press Enter on the QWERTY keyboard or click OK.  
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To rename a track, select the Rename Track command in the Track menu on the PC screen, 
then type the new name for the track and press Enter on the QWERTY keyboard or click OK. 

Seed Names 
Names are given to all new recordings in a Project. You will notice that recordings are given an 
incrementing number for each new clip. Seed names allow you to enter a name prefix that will 
be given to each new recording, to which an incrementing number will be appended. 

Each track has its own Seed Name, but you may apply the same one to many tracks. 

To set the seed name for one or more tracks, do one of the following: 

1. Use the method described above. 

2. Select the Tracks Menu above the Editing screen, and select Set Record Seed Name. 

In either case: 

Step 1 The system displays a dialog box. 

 

Step 3 Enter the Seed Name you wish to use on the selected track(s). 

Step 4 Enter the Seed Index 

This is the number that will be used on the next recording made on any of the selected 
tracks. You may set this to any value you like, even if it has already been used. 

Notes: 

1. The system defaults to the Seed Name “Recorded Audio” on all tracks. This results in 
lots of clips called Recorded Audio N. 

2. Use only the following characters in names: A - Z, a - z, 0 - 9, _ (underscore) 

3. When multiple tracks with the same Seed Name are recorded, the resulting clips have a 
range of numbers, increasing by one with each increasing track number. So for 
example, if: 

• The Seed Name is Clip 

• The next number is 5 

• Tracks 1, 2 and 12 are in record 

Track 1 will get Clip 5 
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Track 2 will get Clip 6 

Track 12 will get Clip 7 

Naming Feeds and Buses 
Feeds and Buses can also be named from the Call menu. Names appear in the mixer display on 
each channel or bus tile. 

Step 1 Press the Call key to enter the Call menu. 

Step 2 Press a feed or bus selection key to call the path to the master fader. 

Step 3 Press the {name} soft key. 

Step 4 Type a name for the signal path and press Enter. 

Press the Tab key to enter the name and step to the next feed. Hold down the Shift key 
and press Tab to move to the previous feed. 

Notes 
Project notes can be captured in a text field, using the following steps: 

Step 1 Press the Notes key. A text window appears on the Mixer screen. 

Step 2 Use the computer keyboard to add text to the window. When complete, press OK to 
save your notes (or press Notes again). 

Step 3 At any time you may return to the Notes window by pressing the Notes key again, and 
can edit the text in the window.
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Chapter 14 -  Clip Level 

Introduction  
The Level Menu allows clips to be amplified and attenuated by up to 99dB. The gain changes 
are performed by the system in real time as the audio is played out from the system. Applying a 
level to a clip does not affect the original recorded audio on disk, but it does affect the 
displayed waveform.  

The level function can operate on multiple tracks, on clips that lie beneath the cursor and also 
within a Range. 

 

Applying a Level Change 

Step 1 Press the Level key. 

Step 2 Select the track or tracks containing the clips you wish to modify. 

Step 3 Locate the cursor over the clip(s) or define a Range that wholly contains the clips. 

Step 4 Press the {set} or {trim} soft key. 

Step 5 Change the level by typing in a value or using the Jogger Wheel. If {trim} was 
pressed, the amount is a level offset for the selected clips. 

Step 6 Press Enter or click OK to make the change permanent. 

The output of each track is displayed on the level meters. 

Range 
A number of clips can be altered at the same time using a Range and track selection. A range is 
created using the From and To keys, as described in“Selecting a Range” on page 36.  

When using a Range, only clips that are entirely within the Range are affected. 

NOTES: 

It is possible, when using the Level Menu, to push the level of a clip over digital full scale. 
Check the meters, to set the level for just part of a clip, then use the split command to break it 
into the right sized pieces, then set the appropriate levels. 

To create a ramp between different levels in one clip, first copy the section whose level is to be 
changed (using the Edit Menu), then paste it back on top of its source. Change its level as 
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desired, then use the Fade Menu to create fades at either end of the clip. This will cause it to 
crossfade with the source clip underneath, which will be playing at the original level. 
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Chapter 15 -  Clip Equalisation 

Introduction  
Satellite-AV provides clip based, four band parametric Equalisation (plus shelving) which can be 
applied to a single clip or range of clips within a Project. EQ is performed by the system in real 
time as the audio is output from Satellite-AV , therefore applying an EQ change does not affect 
the audio data on disk. The clip-based EQ is independent of the track feed mixer EQ. 

Applying EQ 

Step 1 Press the EQ key. 

Step 2 Locate the cursor over the clip or define a Range of clips. 

Step 3 Press the {edit} soft key. 

Step 4 Select the appropriate EQ parameter. 

This can be done using the Numeric keypad, as shown in Choosing a Parameter below, 
or by clicking in the appropriate field in the EQ display above. 

Step 5 Adjust the parameter, using the Jogger Wheel or by typing a value on the QWERTY 
keyboard and pressing its Enter key. Changes are heard in real time. 

Step 6 Repeat steps 4 and 5 as often as needed. 

Step 7 Apply the changes by pressing the Console Enter key, or by clicking the Apply button. 

Each equalisation band has three parameters you can change. They are: centre frequency of 
the band, gain (cut or boost) at that frequency, and Q-factor (sharpness of the band) or 
whether it is a high or low shelf. 

EQ display 
 

 

Left side of display. When a clip’s EQ is being edited, the dots change from black to red (as 
shown here). They can be moved with the mouse, changing frequency and gain values. These 
values are updated in the value grid as you move the mouse. You can also hear the changes in 
the audio if it is playing, after a short delay.  
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Range Filter Type Frequency Gain Q-Factor Enables 

Right side of display. The value grid shows the parameters of the EQ being applied to the clip 
(or range of clips). 
 

Band There are four EQ bands that you can apply. They are given 
the names commonly used on mixing consoles, but actually 
they are not in fixed ranges –  you have the full frequency 
range available on each of them. 

Filter Type Choices are: 

P     Band pass filter 

>-    High pass filter 

-<    Low pass filter 

Each band can be set to any filter type. Mouse-click on the 
button to cycle amongst the choices. 

Frequency The centre frequency of each band. 

Gain The gain of the band. Range -99 to +20dB. 

Q  This displays the Q of the band or indicates the type of shelf. 
Range 0-99. 

Enables Used with the Apply command. Only the Enabled bands are 
applied to the selected clips. 

  

Value Grid 

 

The Value Grid shows all the current parameters of the EQ being changed.  

Choosing a Parameter 

There are two ways to choose a parameter in the grid: 
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Click with the mouse in the cell you would like to change 

Use the Numeric Keypad on your console – the rectangle formed by the 7,8,9 keys at the 
top and the 0,00,Clear keys at the bottom corresponds with the cells in the Value Grid. 

       

In addition, the Frequency and Gain values can directly be chosen and changed using the 
mouse on the graph area. 

Changing a Parameter Value 

There are several ways to change the value of a parameter once chosen: 

• Use the Jogger Wheel – make sure the transport is not in Jog mode at that time. 

• Type in the value using the numbers on the QWERTY keyboard. 

• Use the up and down arrows on the QWERTY keyboard 

• Use the + and – buttons in the Numeric Keypad of your console 

• Press the NUMBER soft key and use the numeric keypad – not recommended. 

• With the mouse, by dragging the red squares in the EQ graph. 

Applying the Changes 

To apply your changes, click the Apply button or press the apply soft key. Only the bands 
whose Enable checkboxes are selected will be applied. 

To escape without applying your changes, click the Cancel button or press the edit soft key to 
deselect it. 

New or Old 
Whilst adjusting an EQ parameter it is possible to toggle between the new and old settings 
using the NEW/OLD soft key, or clicking the New / Old radio buttons, until you apply the 
changes. 

In or Out  

Toggle the EQ on and off with the IN/OUT soft key, or the In / Out radio buttons. 

Copying an EQ 
The EQ parameters of a clip can be copied to another clip or Range of clips. 
  

Step 1 Press the EQ key. 

Step 2 Locate the cursor over the source clip. 

Step 3 Press the {copy} soft key or click the Copy button on the screen. 

Step 4: The enable checkboxes allow you to choose which of the bands are pasted into your 
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target clip(s) 

Step 5 Locate the cursor over the destination clip or define a Range of clips. 

Step 6 Click the Apply button or press the {apply} soft key. 

Parameter Display 

Current EQ parameters are always shown at the top of the screen when the EQ menu is 
active, helping to see what is active and what values are current. The layout of the 
parameter values is exactly the same as the layout on the numeric keypad. A graph helps 
you to see what is going on. 

EQ In/Out 

Use the {EQ In/Out} Soft key to toggle the EQ on or off at any time. This action will affect 
the clip under the cursor, or all clips in the Range, if any. The on/off position of this switch is 
stored in the clip along with the settings of the EQ parameters. 

4. While you are changing parameter values with the jogger wheel, the actual sound is 
updated after a short delay. 

5. Turning the wheel faster increases the steps between values. 

6. There is no limit to the frequency Range for each band, so you can have your low 
frequency higher than your high frequency if you want. 

7. When you are using a Range, it is possible to change one or more bands for the entire 
Range, while leaving other bands as they were. So, for example, the clips might have 
different settings for LOW EQ but the same setting for HIGH EQ. 

Saving EQ Settings 
The system allows you to save the current EQ settings and later retrieve and apply them. 

To save an EQ setting, do the following: 

Step 1 Type a new name into the Presets field (or use an old name if you want to change its 
settings) 

Step 2 Set the EQ values to the ones you want to save, by editing, or simply by “picking up” 
the values by touching an existing clip. 

Click the Save button, or press the {save} soft key. 

To retrieve an EQ setting, select it from the Preset drop list. It can then be applied immediately 
to the currently selected clip or range of clips. 

A saved EQ setting can be deleted by first selecting it from the drop list, then clicking the Delete 
button.
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Chapter 16 -  Time Domain Processing 

Introduction 
Satellite-AV provides Sample Rate Conversion,  Powerful Time Compression and Expansion via 
Serato’s Pitch ‘N Time FE (Fairlight Edition), and  automated dialog alignment via Synchro Arts 
Vocalign Project. 

Sample Rate Conversion 
Step 1 To enter the Wave Menu, press the WAVE key. 

Step 2  Press the {SRC} soft key. The SRC popup appears 

 

 

Use the keyboard and mouse to adjust parameters: 

• Adjust speed, eg 0.8 =80% of natural rate (slower), 1.3 = 130% of natural rate (faster). 

• Click Natural Rate to reset speed. 

• Alternatively, select a target sample rate from the popup. 

• Select a Sample Rate Type 

• Select “Entire Media” or “Clip With Handles” to convert the entire source clip or only the 
visible portion with handles. Handles must be specified in samples. 

• Check “Resize Clip” to match the clip boundaries to the converted length. Uncheck 
“Resize Clip” to maintain the existing clip boundaries. 

• Click “Advanced” to open the Advanced Options pane. 
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• Order:Set FIR order (number of taps is 2 * order + 1). Calculation time is proportional to 
'order'. 

• Beta:Beta values of 2 to 12 are reasonable. For a given order, larger 'beta' reduces pass 
band ripple, but widens the rolloff transition band, so a lower roll off frequency is 
required to avoid aliasing. 

• Rolloff:Roll off frequency must be less than 1/2 of both sample rates. 

• Auto Rolloff:Means Dream II will calculate the required rolloff for you. 
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Performing Time Compression/Expansion 
Serato Pitch ‘n Time FE provides the industry’s finest time compression and expansion. Change 
length without changing pitch, or pitch without changing length, and hear the result in real time 
as you jump from clip to clip. Pitch ‘n Time FE is fully integrated with Dream II’s Binnacle 
controller, allowing for fast, intuitive operation. 

** Note: Pitch ‘N Time FE requires an iLok USB Security Key and a valid license. Licenses can be 
purchased at http://www.serato.com 
  

Step 1 To enter the Wave Menu, press the WAVE key.  

Step 2  Press the Pitch ‘N Time soft key. The Pitch ‘N Time FE popup appears. 

 .  

Use the keyboard and mouse to adjust parameters: 
• Select an Algorithm 

o Polyphonic – best suited for music 

o Vocal – best suited for voice 

o Varispeed – varispeed mode 

• Press the preview soft key or “Preview” button to audition your settings in real time. 

• Tempo changes speed without changing pitch. Use the tempo slider to set the desired 
tempo or press the fit range soft key to capture the current range length or press the 
edit soft key to edit the output duration or type a value in the “Output” box. 

• Pitch changes pitch without changing tempo. Use the pitch slider to set the desired pitch. 
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• Press the process soft key or “Process” button to render your changes back to the 
timeline. A new clip will be created, and the original clip will be muted and preserved in 
the layer underneath. 

Using VocAlign Processing 
** Note: Vocalign Project can be purchased at http://www.synchroarts.co.uk/. Dream II systems 
will recognize Vocalign Project after it has been installed and run at least once.  

Step 1 To enter the Wave Menu, press the WAVE key.  

Step 2  Select two tracks for VocAlign Processing. The first selected track serves as the guide 
track. VocAlign will attempt to match the second track to the guide track. Note that 
VocAlign cannot process clips longer than 120 seconds 

 

Step 3 Press the {VocAlign} soft key. The VocAlign popup will appear. 
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Step 4 Adjust VocAlign parameters or use defaults (see the VocAlign manual for details). When 
you are ready, press the “Align” button or the align soft key. A new clip will be created 
on the Dream II timeline, and the original clip will be muted and preserved in the layer 
underneath 

 

Render 
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Chapter 17 -  Solo and Mute 

Introduction 
DREAM II provides two independent solo and mute systems. The solo and mute features 
described in this chapter are integrated into the disk recorder system, and apply only to tracks, 
not Live Feeds, Buses etc.  

They offer a fast method of controlling which track feeds are played. The solo and mute 
functions described in this chapter can be used in conjunction with the Mixer Screen solo and 
mute features which are described elsewhere. 

The Track Display SOLO and MUTE functions mirror the solo and mute buttons on the Satellite 
controller. SOLO mutes all tracks except for the soloed ones, MUTE silences only the selected 
tracks. Both the SOLO and MUTE functions can be activated by pressing the Solo or Mute key 
then selecting the desired tracks, or by using the Mouse and onscreen ‘M’ and ‘S’ buttons.  

    

Soloing Tracks 
Step 1 Press the Solo key. 

Step 2 Select tracks to SOLO.  

Step 3 Press the Solo key again to exit, or any other mode key. 

Indicators next to the track numbers show green for soloed tracks. 

Muting Tracks 
Step 1 Press the Mute key. 

Step 2 Select tracks to mute. 

Step 3 Press the Mute key again to exit, or any other mode key. 

Indicators next to the track numbers show a red M on a yellow background for muted tracks. 
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Chapter 18 -  Go To 

Introduction 
The Go To Menu is used to locate to timecode locations or named clips. After the transport has 
located to the target, you will be returned to the mode you were in before the GO TO command. 

Go To a Timecode location 
Step 1 Press the GO TO key. The {time} soft key is already selected. 

 

Step 2 The system displays the last used (or captured) timecode. If desired, type over the 
timecode using the numeric keypad or the QWERTY keyboard. 

  

Step 3 Press Enter or click OK to move to the new timecode location. 

Editing Timecode Numbers 
The following shortcuts can help to speed up Go To operations. 

1. The left and right arrows on the QWERTY keyboard can be used to move from field to 
field in the timecode number. You can then start typing the timecode number from that 
field. 
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2. The up and down arrows on the QWERTY keyboard can be used to increase or decrease 
the current timecode field by one. 

3. The current timecode can be captured using the TC Capture key. This number will 
appear next time the Go To command is issued. It can be used to temporarily “hold” a 
timecode where you would like to return very soon. 

 

The preceding key sequences can be used for precise editing. For example, to move exactly one 
second backwards, use the following sequence: 

Capture Timecode 

Go To 

Left Arrow twice (three times if subframes are being displayed) 

Up Arrow 

ENTER 

A sequence like this can be very handy when used in a macro. 

Go To Clip Name 
The Go to Clip function locates the transport to the head of the desired clip. It also incorporates 
an alphanumeric search function to help sort through clips by name. 

Step 1 Select GO TO 

Step 2 Select {clip}. 

The TC Capture key 
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Step 3 Clip names are listed on the video display. Select the desired clip using the mouse. 

You can shorten the list by typing a sequence of characters. Only clip names containing 
that sequence will be shown, so as you type more characters, the list will get shorter and 
shorter. 

 Step 4 Press Enter. 

  

The clips can be sorted in track order, start order, end order or duration, by clicking on the 
column header. Clicking a header item a second time reverses the sort order. 

Go To Mark 
The Go to Clip function locates the transport to the head of the desired clip. It also incorporates 
an alphanumeric search function to help sort through clips by name. 

Step 1 Select GO TO 

Step 2 Select {mark}. 

Step 3 Marks are listed on the video display. Use the Jogger Wheel to scroll up and down the list 
of marks, or use the mouse to click on the desired mark. 

Step 4 Press Enter. 

While viewing the list of marks, you can also select and edit them, changing their names and 
timecode locations.
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Chapter 19 -  ADR 

Introduction 
Satellite-AV provides the ability to automate recording using a list of In and Out points with a 
simple interface. The ADR menu includes functions for setting pre and post-roll and features for 
automatic dialogue replacement. 

The ADR List 
The ADR List allows you to set up a list of recordings – cues –  that you want to take. Each one 
has a controlled In and Out point, and text that can be displayed on the screen. 

To open the ADR List, press the ADR button (recommended), or click the ADR Menu above the 
Track display, and select ADR List. 

 

When it is first opened, the list is empty of cues. 

Adding a Cue 

Step 0 Optionally, create a range covering the cue you want to add. This is probably the 
quickest way to set the In and Out times for your cue. (If there is no range, the cue will 
be created with the transport position as its In time, and 5 seconds duration.) 

Step 1 Click Add or press the {add cue} soft key 

 A dialog appears for writing the text of your cue. 
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Step 2 Enter the text and click OK 

Step 3 If necessary set the In Point of the cue: locate the transport to that point and click 
From. Your current position will be shown in a dialog. You may accept this by clicking 
OK. 

OR 

Click From, type the timecode you want, and click OK. 

Step 4 If necessary set the Out Point of the ADR cue in the same way. The cue is shown as 
below. 

 

Once you have entered all the cues that you want to use, you may set up your preferences by 
clicking the ADR Menu and selecting ADR Preferences. The following screen is displayed. 
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The main purpose of this dialog is to control beeps and the streamer. The streamer is a band 
across the screen which displays the ADR text, and also gives an indication of the start point for 
the cue. An example of the streamer is shown below. 

 

The text is shown, and the indicators converge on the centre of the screen, arriving at precisely 
the In time of the cue. 

To turn on the Streamer, click the ADR Menu above the Track display, and select ADR Display. 

Cycle 
The Cycle command is used to initiate ADR actions. It will execute rehearsal, recording and 
playback, depending on the mode of the ADR system. See below for details. 

Preroll and Postroll 
It’s usually necessary to set a preroll for recording. This allows the recording artist to get ready 
for the start. 

Postroll is useful for hearing how the new recording fits into the track. 

Set preroll and postroll using the appropriate fields in the ADR List. 

Rehearsing a cue 
You may rehearse cues before recording them. Is this needed in a system where all recording is 
non-destructive? Your call. 

Step 1 Click the Rehearse button or press the {REHEARSE} soft key. This puts the ADR system 
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in Rehearse mode.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle or press the {cycle} soft key. This will cause the transport to drive through 
the In and Out points once, switching the track from repro to input, simulating the 
record experience. 

Click the Stop button at any time to stop the take (or use the Stop button in the transport 
controls). 

Note: When the ADR is in Rehearse mode, double-clicking a cue will select it and initiate a 
rehearsal Cycle. 

Recording a cue 

Step 1 Click the Rec/Playback button or press the {RECORD / PLAYBACK} soft key until its label 
is RECORD. This puts the ADR system in Record mode.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle. This will cause the transport to drive through the In and Out points, 
recording a take, then cycle through again for playback. 

Click the Stop button at any time to stop the take (or use the Stop button in the transport 
controls). 

Note: When the ADR is in Record mode, double-clicking a cue will select it and initiate a 
recording Cycle. 

Playing Back a cue 

Step 1 Turn off the Rec/Playback or Rehearse button if on, or press the {RECORD / PLAYBACK} 
soft key until its label is PLAYBACK. This puts the ADR system in Playback mode.  

Step 2 Select a cue. The transport will locate to its In Time. 

Step 3 Click Cycle. This will cause the transport to drive through the In and Out points once, 
playing back the audio. 

Note: When the ADR is in Playback mode, double-clicking a cue will select it and initiate a 
playback Cycle. 

Pre-Record 
Pre-Record allows you to enter record a little earlier than the time of the cue. This is useful 
when recording artists that tend to anticipate the entrance. The streamer will still indicate the 
cue in time, but you are able to capture the audio a little earlier. 

Early In 
Early In can be clicked during the preroll of a record cycle. It causes recording to start 
immediately. 

There is also an {early in} soft key. 

Rec Out 
If desired, the system can ignore the Out time of the cue, and just keep recording until you exit 
manually (using Stop, Jog, Rewind etc). 
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The {Rec Out} soft key can be set to PROG (programmed exit) or OPEN (keep recording until 
manual exit). 

The Rec Out screen button does the same. When selected (blue) the record Out time will be 
obeyed. When unselected (grey) manual exit will be used. 

Keep Playing 
At the end of a cycle you may wish to keep playing, in order to hear the next section of track. 

Pressing the {keep playing} soft key at any time during a cycle will cause the postroll to be 
ignored, and the system will enter normal Play mode after the cue’s Out time. 

Importing ADR cue lists from a text file 
You may import an entire script through the use of the Import button. This can import a short 
script that has been written in a word processor. 

Each line of text in the file is treated as a separate line of ADR cue text. 

Each line of text can optionally have one or more timecode numbers at the start of the line: 

00:00:00:00 This line has one timecode number 

or 

00:00:00:00 00:00:01:12This line has two timecode numbers 

The first timecode number becomes the cue-in point and the second, if present, the cue out 
point. Timecodes must contain 4 individual numbers separated by colons: 01:00:23:12 or 
semicolons if the timecode is drop-frame based: 01;01;00;02 

Here is an example of a text file in the correct syntax with timecode numbers at the start of 
each line: 

00:02:19.19 Her eyes shined bright and true 

00:04:57.07 00:09:42.18 Do not look now, but.... 

23:58:39.03 00:02:58.19 Haven't I seen you before. 

The format described above is the native format used by Pyxis NLV for storing ADR cue lists. 
You can edit the stored ADR cue lists directly in any word processor or text editor, as long as 
you make sure you save the file as a text file.
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Chapter 20 – Project and File 
Management 

Introduction 
To further enhance Project Management within Satellite-AV , the following features within the 
Project Menu are available. 

Save As 
In DREAM II, all the audio is stored in large container files, while projects contain “references” to 
those files. So a clip in a project has instructions to access portions of audio recordings in a 
container file. 

Saving a Project under another name creates a new Project with all the same clips as the 
original. It also inherits all the track names and marks, mix and setup information.  

Step 1 Click the File menu button above the Track display. 

Step 2 Choose Save As 

Step 3 Select the desired destination and type the new name. 

Step 4 Click Save 

File Management 
File management is always a necessary “evil” associated with all computers, and is always a topic 
for discussion. We have done our best to make DREAM II file administration flexible and intuitive. 

Audio and Video Devices 
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These are nothing more than 2 separate logical devices, and could be one or more physical 
drives, that DREAM II uses independently for Audio and Video. 

Audio and video have different data transaction requirements, and therefore each have their own 
storage needs. Because of the relatively small size and large number of files used in audio, 
processing becomes very transaction intensive. By comparison, video applications usually require 
extremely high bandwidth due to the constant demand for a smaller number of larger files. 
Therefore we use these 2 dedicated devices in order to optimize disk bandwidth and performance 
for each application. These devices are simply NTFS formatted. 

Media and Projects 
DREAM II uses separate directories to store projects and media for each device ( Audio & 
Video. ) DREAM II may also store data on a mapped network drive. 

 

 

Default Media Device 
When DREAM II is first started it displays a dialogue box requesting that a default project device 
be selected. Select the devices ( Audio and Video ) you wish to use from the list of available 
drives. 

To prepare the drive for use with DREAM II, select Setup > Media and Project Management  
from the DREAM II main menu. Select the device from the devices list and click on Convert to 
Media device. Please also set the Device Info accordingly. 
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To use a network connected device, first create a mapped network drive or folder in Windows 
Explorer. This can now be selected in the device panel and converted to a DREAM II Media 
device as above. 

For those of you out there already using Pyxis … this interface should all be familiar. 

.MT Projects 

INTRODUCTION 

DREAM II, as its Fairlight predecessors, uses the concept of Projects (.MT files) to store work 
performed on the disk recorder. 

All audio recordings, editing and file imports are administrated within Projects. A project can 
contain all the audio data and edit information or references to such.  

Edits performed on the audio data are non-destructive and are represented by clips which refer 
to pieces of audio data within the project. Projects are continually updated and written to an 
undo file on disk while recording and editing is being performed as a security measure. 

Existing .MT projects coming from MFX3+s, or QDC engines can all be opened on DREAM II. 
Extensions and attached files will be entirely compatible and easily opened. 

FUF Files 
Fairlight Universal Format file. 

This is now, in DREAM II,  a unique file type that is used to write, store and append data. In 
other words, this is now the file type that contains all of the audio data. Let us look now at a 
working and real example to understand how it is used. 

We will create a new project: 

Step 1 Click on the <File> menu and you will see a pop-up window appear. 
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Step 2 Choose or create a specific folder for your project,  

Step 3 Enter the project name.  

Note: Fairlight projects use a 28 character filename limit to ensure compatibility with previous 
Fairlight systems.  

Step 4 You can add comments, choose the sample rate, frame rate, number of audio tracks 
required, and last but not least, choose to add a Pyxis track. 

As an illustration, record some tracks into your project (please see Recording if this is new) 

Browse to the folder where you have created the project ( in this example – New Project1.MT ) 
and have a look: 
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You will see the project … and you will also see the FUF file NewProject1_001.FUF 

The .MT file contains all the EDL information. The FUF file actually contains all the audio data. 

Please note that you can also use the Clip Search function to see exactly the same thing: 

 

Step 1 Open the View menu and Click on <Clip Search>. You will see all the clips that belong to 
the currently open project. Now click on <Reveal File>. This will bring up a Windows 
pop-up window that points to this FUF file. 

Important 

A FUF file has a size limitation of 4Gb. When the audio data contained in an .MT project reaches 
this limit, another FUF file is instantly created in the background, allowing you to continue 
recording or entering audio data. This new file is “attached” to the original. 
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This can happen up to 250 times, giving a project limit of around 1 terabyte. 

.WAV files and .AIF 

.Wav files, .BWF files, and .AIF can be imported (drag and dropped) into an existing .MT project. 
These file types must be sourced from a DREAM II media device. The files are played in real time 
within the current .MT project and are considered “attachments” or “borrowed” files. 

These borrowed files contribute to the count of 250 attachments that are allowed, so it is good to 
consolidate them into the main file if many are to be used. This is described in the next section.  

Stuff the FUF 

 

To consolidate all attached files (.Wavs, .BWFs, .AIFs) directly into the .MT project 

In the Process menu there is a feature called <Stuff Fufs> (see above). This will append data 
coming from the “attached” files into the FUF, thereby consolidating them. This can be done on 
several different levels: 

1. One clip 

2. A range of clips and tracks. *individual clips can now be selected or de-selected within 
this range using <Ctrl-Click>* 

3. All clips - This is the equivalent of a <Keep Borrowed> on previous Fairlight systems. 

Save As 
<Save As> can be used to make multiple versions of the same .MT project. If <Save As> is 
used, the actual audio data will still remain in the original project, whose FUF file will be 
“attached” to the second one. 

If new recordings are made into the second file, they will be written into a new associated FUF 
file. 

To consolidate all of the audio into the new version, use the function <Stuff Fufs – All Clips>.  
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Chapter 21 -  Marks 

Introduction 

Marks 
A mark is a stored time location in a Project, indicated by a yellow pointer on the timescale. 
Satellite-AV can store 1000 marks with each Project.  

Marks can be given names and can be used as location points. 

Video Locators 
Video Locators are a special class of Marks that are created by dragging video frames to the 
Locator thumbnails in the Dream II Pyxis track: 

 

Video locators are also indicated by yellow pointers on the timescale, and are simply marks that 
reference a specific frame of video. 

Creating a Mark 
To create a mark, locate the transport to the desired point and press the Mark button. Marks 
are shown as yellow indicators on the timescale. 

Video Locators 
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Editing Marks 
To edit marks, select View/Locators from the onscreen menu, or press BLUE-Mark. 
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Click the appropriate button to set the Mark time, rename the Mark or remove it. 

GOTO Mark 
The GOTO menu allows the transport to jump to any named mark including the head and tail of 
the project. Press the GOTO key, press the {Mark} soft key and turn the jog wheel to select a 
mark. Press Enter to locate to the mark point. 
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Chapter 22 -  AudioBase  

Introduction 
AudioBase3 is a library database which allows you to search for WAV files on your Medialink2 
server via a standard Windows network. Once a WAV file has been found, it may be auditioned, 
and then imported into the current open Project. 

Creating and Maintaining Databases 
Refer to the AudioBase3 User Guide for details on creating and maintaining clip databases. 

Searching for Sounds 
AudioBase3 uses a simple search interface to find clips: 

Step 1 Press the AudioBase key. The search field becomes active. 

Step 2 Enter the text you wish to find. All relevant database fields will be searched. Use quotes 
to find matching phrases. 

Placing Sounds In A Project 

 

Step 1 After searching the database, a list of matching clips is displayed. Ensure the transport 
is in STOP, then use the jogger wheel, + and – keys or up and down arrow keys to 
highlight the clip you want. 

Step 2  Click the Preview button in the Smart Pane or the {Preview} soft key. If Preview is lit, 
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the highlighted WAV file in the list will loop repeatedly. 

You can use the Jogger wheel, the + and – keys in the numeric keys section of the 
control surface, or your keyboard 

Step 3 Double-Click the selected WAV file to paste it at the playhead on the active track, or 
drag and drop a clip to any track at any point on the timeline. 

Notes: 

• The AudioBase3 results pane can be displayed underneath the Pyxis Track, allowing 
easy placement of sounds to picture. 

• To hide the AudioBase3 results list, simply enter another mode (e.g. Cut). 

• Set up your AudioBase3 Server in Setup/General Preferences. Example: 
http://192.168.1.100/AudioBase/MFX/search.php (Where 192.168.2.100 is the IP 
Address of your MediaLink2 Server)
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Chapter 23 -  Import /  Export 

Introduction 
Satellite-AV has a number of features to allow the import and export of audio clips and Projects. 

Importing Files 
DREAM II can import the following file types: 

Video Files – these can be displayed on the Pyxis track 

OMF Files – these are files from other manufacturers 

ML Files – these are files from older Fairlight products. 

Importing a Video File 
  

Step 1 Make sure that a Pyxis track is displayed. If it is not displayed, 
click the Tracks menu above the track display, then click Add 
Pyxis track. 

Step 2 Click the File menu above the track display, and select Import, 
then select Video File. 

Step 3 The following dialog box is displayed 

  

This dialog box allows many complex conversion 

Export 
The Export Menu is used to allow audio to be exported from a Project in the following formats: 

Click here to 
search for the 
file you want 
to import 



Satellite-AV User Manual CHAPTER 23 - IMPORT / EXPORT  

Satellite-AV Page 149 

• WAV  

• Broadcast WAV 

• Aif 

Step 1 Select the clip or clips to be exported. Ranges of clips can also be selected. 

Step 2 Click the File menu command above the Track display. 

Step 3 Choose Export, then Audio Track(s) 

Step 4 The following dialog box appears. 

 

 

Make your selections and click OK. 

Channels 

If Mono is selected a single Mono file will be exported. If Stereo is selected a single Stereo file 
will be exported. If Multiple Mono Files is selected one mono file will be exported for each 
selected clip on each selected track. 

File Type 

Select Wav, BWave or AIF files. BWave files will be exported with the timecode stamp from the 
Dream II timeline. 

Export Using 

Select Clip EQ and/or Clip Level to render Clip EQ and/or Clip Level into the exported file(s). 

Audio Type 

Select bit depth and Sample Rate for exported file(s). Defaults to Project sample rate and bit 
depth. 

Mixdown 

Select ‘Entire Project’ to export the entire project (one file per track in Multiple Mono Mode). 
Select ‘Between Range’ to export all audio in the current range (one file per track in Multiple 
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Mono Mode). Select ‘Selected Clips’ to only export selected (red) clips (always one file per clip, 
regardless of selected Channels). 

Check ‘Selected Tracks Only’ to only export selected tracks. Check ‘Align to Video Frame 
Boundaries’ to align exported file(s) with the video frame edges. Check ‘Export Empty Tracks’ to 
export blank files for empty tracks (if Multiple Mono files have been selected). 

Normalize 

Normalize will examine the level in every clip you have selected, find the maximum level of all 
the clips, then show the gain increase needed to bring it up to 0 dB. Then all the clips will be 
amplified by this amount, giving you the loudest (best quality) signal possible while maintaining 
correct balance.
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Chapter 24 -  Timecode Setup 

Introduction 
The Setup Menu is used to configure the Project’s synchronisation setup. 
  

Step 1 Press the Setup key or click View>Smart Pane> Sync Setup 

 

Step 2 The following dialog is displayed 

 

Sample Rate 
This value can only be changed before there is any audio in the Project. Once it is set, the first 
recording will lock that value into the project. 

Frame Rate 
Can be changed at any time. Normally it is best to choose the frame rate of the Master video 
device in your system, or of the timecode being chased, if any. 

Bit Depth 
Can be changed at any time. All subsequent recordings will have this depth. 

Extn Video Rate 
This is the rate of the external video reference applied to the SX-20. This must be set properly 
for correct operation! 
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Pull Up/Down 
Allows setting of Pull Up and Pull Down, often used in NTSC video setups. Detailed explanation 
below. 

Sync Source 
The system sample rate is synchronised to its clock source. There are many choices, but normally 
you will use the SX20 as a sync source, and lock it to whichever sync signal your studio is 
running. 

Synchronization Indicators 

Det’ Sample Rate 
Detected Sample Rate indicates the speed at which Dream II is running. This value is determined 
by the relationship between the External Video Rate, the project Frame Rate, the Pull Up/Down 
setting and the project Sample Rate. 

Video Detect 
The Video Clock Detected indicator is green when a valid Video Clock reference is detected and 
red when Video Clock is missing or invalid. 

Seeking Lock 
The Seeking Lock indicator is green when seeking lock, and red when not in use or locked. 

Sync 
The Sync indicator is green when a valid Clock Sync Source reference is detected, and red when 
the Clock Sync Source is missing or invalid. 

Progressive Detect 
SX-20 supports both Progressive and Interlaced clocks. If the Progressive Clock Detect indicator 
is green, a Progressive Clock reference has been detected and is being used as the primary sync 
reference. 

Clock In Range 
The Clock In Range indicator is green when the Clock reference is in range and red when the 
clock reference is out of range. 

Position Sync 
When synchronising with an external machine such as a video machine, audio recorder or digital 
audio workstation, a positional source allows the machines to “tell” each other where they are. 
The Position Sync Source indicator is green when a valid Position Sync Source reference is 
detected, and red when the Position Sync Source is missing or invalid. 
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Synchronization Details 
Satellite-AV can track the position and motion of external transports such as a video tape 
recorder, timecode-striped audio tape or a timecode generator. The disk recorder will play in time 
with the Master Timecode source so that sound and picture coincide. 

Position 
This is an absolute location reference to a sequence of pictures or audio. It is used to determine 
whether the disk recorder is playing the right part of its Project. For video, position reference is 
usually provided by 9 pin (Sony protocol from an RS-422 port). For audio tapes LTC is normally 
used (though 9 pin is also a possibility). 

Motion 
The motion of an external machine is a measure of its speed, and the disk recorder must move 
at the same speed to remain in sync. This translates into producing the correct number of 
samples every second, which is called the Master Clock rate. This can be locked to a Digital Word 
Clock, a video signal, an AES/EBU signal, by the internal crystal, a timecode source, or a digital 
audio source which is being recorded. 

If the Position Reference and Motion References are not the same, it is possible that they will 
drift apart over time. This will be shown by a warning at the top of Satellite-AV ’s video screen 
which indicates when an inconsistent timecode frame was encountered. 

How DREAM II  Synchronises 
DREAM II goes through a number of steps in achieving synchronization in play mode: 

1. Read the position reference and start loading up the corresponding audio on all active 
tracks. 

2. When ready, start playing, but with the outputs muted. Use variable speed to reduce the 
error between the Satellite-AV position and the Position Reference until it is very small. 

3. Switch to the Motion Reference for continued playback. The system is said to be locked 
once this switch is made, and the audio is unmuted. 

4. Warn of error status if the sync error increases, if a reference signal is lost etc. 

 Synchronization Conflicts 
When you are recording a digital source, it must be synchronised to the same Master Clock 
Reference as Satellite-AV, or an overflow (too many samples) or underflow (too few samples) 
may occur at the input. This causes a characteristic, periodic form of digital distortion called a 
whisper. A whisper sounds like a brief, glassy or metallic buzz, and occurs about once every few 
seconds, depending how fast the samples are overflowing or underflowing. 

The best solution to digital sync conflicts is to drive all digital devices from a single, studio-wide 
word clock signal. Then all devices will have identical word rates, so whispers never occur and 
digital interconnections may made with ease. In this instance, the sync HOUSE option is always 
used. 
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Pull-Up and Pull-Down 
The normal sample rates used by the digital audio industry are 32,000, 44,056. 44,100, 48,000 
and 96,000 samples per second. The normal frame rates are 24, 25, 29.97 and 30. These last 
two may cause confusion when used together. 

Satellite-AV can alter its sample rates far enough to accommodate the small speed change 
caused by going from 30 to 29.97 frames per second and back again.  

In other words, if you slow down the frame rate from 30 to 29.97, Satellite-AV can slow its 
internal sample rate to match. This is called Pull-up or Pull-down, depending in which direction 
you are taking the speed. 

When you choose a frame rate you are telling Satellite-AV what frame rate to expect. To put it 
more accurately, you are telling it the frame rate at which the chosen sample rate will be 
accurately reproduced. For example, if you tell Satellite-AV that the NTSC frame rate is 30 (in the 
Setup Menu) and the sample rate is 44,100, it will pull down the sample rate to 44,056 if you 
feed in timecode at 29.97.  

If, however, you change the NTSC field to 29.97, Satellite-AV will play at 44,100 at 29.97 frames 
per second, and will pull up to a sample rate of 44,144 when timecode runs at 30 frames per 
second. 

It is advisable to choose a sample rate at which you want to make the final transfer of the 
Project. Then record your material at whichever frame rate is going to be used during that final 
transfer. The importance of this choice is that you do not want to compromise the quality of your 
final product by using sample rate conversion at the moment it leaves Satellite-AV for the last 
time.  

You should make these choices at the very beginning of the Project, and then you may use any 
other combination that suits your purposes temporarily during the recording and editing process. 
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Chapter 25 -  Machine Control 

Introduction  
Satellite-AV can communicate with industry standard Sony 9 pin serial controlled machines (with 
a timecode reader installed) providing control over external video (or audio) machines, directly 
from the Satellite-AV. 

Satellite-AV can control up to three machines: M1, M2 and M3. 

 

Step 1 Press the BLUE-M1, BLUE-M2 key or click View>Smart Pane> 
Machine Control 

Step 2 The following dialog is displayed 

 

 

Use the type soft key or ‘Type’ popup to select one of the following machine types: 

• TC Master – the selected machine is the 9 Pin timecode master. 

• Chase (slave) - the selected machine is in 9 Pin chase mode. 

• Remote (slave) – Dream II will respond to 9 Pin remote commands like a “virtual VTR”. 

• LTC Master – the selected machine is set to chase external Longitudinal Time Code. 

• MTC Master – the selected machine is set to chase external MIDI Time Code. 

• No Port – No port selected 

Note: You can have only one Master machine at a time, but you can have as many slave 
machines as you like (limited only by available ports). Master and Slave machines can be used 
concurrently. 

Press M1 and/or M2 keys or use the ‘Enabled’ checkbox to place machines online. 

Enter an Offset if desired. 

Use the red Video, Analog and Digital LEDs to arm tracks on your remote device as required. 

Note: The master ‘Video Arm Enabled’ box must be checked and each video ‘Arm En’ box must 
also be checked on the desired device before the Video arm LED can be used to arm the video 
track. 

Click the ‘Eject’ button to eject tape from the desired device. 

Note that controls will only appear if they are relevant to the selected device type. 

Machine Control Indicators 

Name 
Name of the 9 Pin Device. 
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Servo LEDs 
The left Servo LED is green when the 9 Pin device has servo lock. The right Servo LED is green 
when the 9 Pin device has sync lock. For correct operation with 9 Pin devices, both LEDs should 
be green. 

Timecode 
Displays the current timecode position of the external device. 

Status 
Displays the device status. 

Asm 
Indicates the 9 Pin device is in Assembly Edit Mode. 

Inh 
Indicates the 9 Pin device is in Record Inhibit mode. 

Ref 
Indicates the 9 Pin device is receiving a valid external sync reference. 

Editing with Machine Control 
All the transport controls and locating methods operate with a 9 pin remote machine online. 
The following procedure is used to place new recordings or previously used clips to picture. 

Press the M1 key to toggle the 9 pin machine on or off. Satellite-AV s transport will locate to the 
timecode from the 9 pin machine. The system defaults to M1 controlling 9 pin Port A. 

Placing Sound to Picture 
  

Step 1 With M1 online, locate the video at the desired frame. 

Step 2 Take M1 offline. 

Step 3 Locate the transport so the cursor lies on the sync point of the 
clip. 

Step 4 CUT or COPY the clip to the clipboard. 

Step 5 Place M1 online, the transport will relocate to the video at the 
desired frame. 

Step 6 Press <Enter> to paste the clip.  

It is also possible to CUT or COPY the clip before locating to the desired frame.
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Chapter 26 – Plugins and ReWire 

Introduction 
Dream II provides powerful support for 3rd party hardware and software plugins via the industry 
standard VST, VSTi and ReWire protocols. Dream II’s open architecture provides access to a 
vast array of 3rd party products, giving users incredible freedom of choice. 

VST and VSTi 

About VST 
VST (Virtual Studio Technology) is an audio plug-in standard created by Steinberg. The VST 
standard allows third party developers to create VST plug-ins for use within VST host 
applications, or to create VST  host applications themselves. The VSTplug-in standard is the 
most widespread plug-in standard in use today, with thousands of available plug-ins. 

The VST Host 
A VST host is a software application or hardware device that allows VST plug-ins to be used in a 
logical context, interacting with digital audio and MIDI elements. Dream II is a VST host, 
enabling VST plug-ins to interact with the Dream II mix environment. As of this writing, Dream 
II uses version 2.4 of the VST SDK (Software Development Kit). 

VST Effects versus VST Instruments (VSTi) 
A VST effect is a type of VST plug-in that is used to process audio. A VST effect might be a 
Reverb, Compressor, Flanger or EQ. 

A VST Instrument is typically used to synthesize sound or play back sampled audio. VSTi’s have 
rapidly replaced hardware synthesizers and dedicated samplers due to their flexibility, 
repeatability and low cost. 

Using VST Effects in Dream II 

Setup and installation 

Step 1 Install your plug-ins as outlined by your plug-in manufacturer. The plug-in will generate 
a file with extension ‘DLL’ in the folder that your plug-in has been installed (most 
commonly located in C:\Program Files\VSTPlugins). 

Step 2 Copy the DLL file and paste into C:\Program Files\Fairlight\Dream II\Effects\VSTPlugins. 

Step 3 Restart the Dream II PC. 

NOTE 1: Files required for copying into Fairlight’s VSTPlugins folder varies between plugin 
manufacturers.  See manufacturers website or documentation on installing their 
products in different systems for more details. 

 

NOTE 2: After installing new vst plugins, forcing Dream II to rescan its plugin folder can guard 
against plugins not being recognised. To do this got to “C:\Fairlight\Dream II\Effects” 
and delete “FXConfiguration.xdr” and “FXConfiguration.xml”. Dream II will then rewrite 
these files on restart. 
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Inserting a Plug-in on a Track Feed  

Step 1 Call the track using the Call key located on the Track fader. 

Step 2 Press the Insert key 

Step 3 Press the {Add Plug-in} soft key. 

The LCD will now display the list of plug-ins that you have installed.  

Step 3 Using the jog wheel, scroll through the list of plug-ins. 

Step 4 When the desired plug-in is displayed, press the {Add} soft key.  The plugin popup will 
now appear on the Dream II Editor display.   

Step 5 To remove the plug-in, press the {Remove Plug-In} soft key. 

Inserting a Plug-in on a Live Feed  

You can insert a plug-in on a live feed by repeating the steps above. Using this approach, you 
can patch an Aux Output to the Live Input using the Patch I/O page. Now all channels feeding 
the Aux will be routed through the Plug-in Effect. 

Using VST Instruments in Dream II 
While Dream II does not include a MIDI sequencer, VST Instruments can still be played “live” 
through the system. This can be useful for: 

• Foley, using a VSTi sampler. 

• Live musical performance. 

• Tuning vocals with a VSTi sampler and MIDI controller with pitch wheel. 

• Live effects triggering with a VSTi sampler. 

VSTi’s can easily be recorded to tracks or inserted on Lives depending on your needs.  

ReWire 

About ReWire 
ReWire is a software protocol jointly developed by Propellerhead and Steinberg. ReWire enables 
remote control and data transfer among digital audio editing and related software. Originally 
appearing in the ReBirth software synthesizer in 1998, the protocol has since evolved into an 
industry standard. 

The ReWire Mixer 
The ReWire protocol is designed to allow a number of ReWire Clients to communicate with a 
single ReWire Mixer. Only one ReWire mixer can be active at a time. Dream II is always the 
ReWire Mixer. 

The ReWire Mixer can accept up to 256 inputs from each of the connected ReWire clients. 
Dream II currently supports 96 of these ReWire inputs. When a ReWire Mixer and ReWire Client 
are connected together, transport controls and position information are automatically 
transmitted in both directions between the Mixer and Client(s). 
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Diagram of a running ReWire session 

 

Using ReWire Devices in Dream II 

Setup and installation 

 
Step 1 Install your software as outlined by your the manufacturer.  

Step 2 Run the software at least once in standalone mode. 

Step 3 The software should now appear in the list of available ReWire 
devices. 

 

Launching a Rewire Application 

In order to patch a Rewire device, a Rewire application must be installed first (e.g. Reason, 
Ableton Live). 
 

Step 1 Click on ‘Setup’ in the Dream II toolbar. 

Step 2 Select ‘Setup Instruments’ to launch the dialogue box. Your 
Rewire application should appear in this list. 

Step 3 Click on the name of the desired Rewire application so it is 
highlighted. 
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Step 4 Click on ‘Edit’ at the bottom of the dialogue box.  Note: Some 
programs (eg – Reason) will launch automatically.  Others (eg - 
Ableton Live) need to be launched manually. 

Step 5 Open or create a project within your Rewire application (demo 
projects that accompany the application are a good starting 
point).    

Patching a Rewire Application 
Once your Rewire Application is launched, it’s time to patch Rewire inputs to track or live feeds. 

 

Step 1 Open the Patch I/O page by pressing the Patch I/O key on the 
channel panel. 

Step 2 Click on Instrument Inputs located on the left hand side of the 
Patch I/O page. You see inputs labeled according to the Rewire 
applications you have installed.  If you have installed more than 
one application, click ‘Page Down’ on the patch I/O page until 
you find the input for your Rewire application. 

Step 3 Select the desired instrument input (e.g. If using Reason, select 
the inputs labeled Mix L and Mix R for a stereo mix). 

Step 4 Select Track, Live or other patch destinations located on the 
lower right hand side of the Patch I/O page.   

Step 5 Select destinations to patch in the upper right, and click the 
Patch button to complete the patch. 

 
 

Highlight rewire 
application 

Click on edit to 
launch 
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Select live inputs

 
 
 
 

 
 

You should now be able to hear a stereo signal generated by your Rewire application on Live 
feeds 1 and 2.  Alternatively, you can patch instrument inputs to track feeds, but make sure the 
track is record enabled in order to hear your Rewire device (see Chapter 10 - Recording).  

 

Click on Patch to 
complete 

Select instrument 
input 
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Chapter 27 -  System Files 

Introduction 
Satellite-AV uses a number of files to store setup information. These are normally set 
to sensible values at the factory, but in some cases you may need to change them.  

Working with Satellite-AV System Files 
System files are stored in the C:\Program Files\Fairlight\FMC\Data directory. Use 
Windows explorer or use the trackball to click on My Computer, on the desktop, to 
navigate through the file system. Use the Notepad text editor to edit files by double 
clicking on the file name. 

The I-O Config.TXT File15 
The I-O Config.txt file specifies what I/O hardware is fitted with your CC-1 engine. 
This file must be edited to allow the Satellite-AV to properly address the physical I/O 
hardware. The I-O Config.txt file is stored in C:\Program Files\Fairlight\FMC\Data 
directory. Open the file with the Notepad text editor, define the physical I/O as 
described in the file. You can also name individual I/Os which will then bring their 
names up on the FAT channel when you patch them. 

System Ports 

System output ports can only be accessed from the Monitor Setup Patch Outputs 
menu. Using system ports for control room monitors prevents the operator from 
inadvertently patching signals direct to the power amplifier inputs. To define a system 
port enter an attribute value of 1 as described in the I-O Config file. 

The file contents are similar to the following: 
# -------------------------------------------------------- 

# I/O configuration 

# There are three types of I/O: 

# 1 is Analog 

# 2 is AES 

# 3 is MADI 

# -------------------------------------------------------- 

# First define the number of different types of I/O: 

# IO_CONFIG,type,inputs,outputs 

# where 

# IO_CONFIG,1,16,8 

# IO_CONFIG,2,32,16 

# IO_CONFIG,3,0,0 

# would configure the system with 16 analog IPs, 8 analog 

# outputs, 32 digital IPs, 16 digital OPs and no MADI 

# -------------------------------------------------------- 

# These ports are then define one by one using a number 



Satellite-AV User Manual CHAPTER 27 - SYSTEM FILES 
 

Satellite-AV Page 163 

# of statements like these: 

# INPUT,type,index,name,attibutes 

# OUTPUT,type,index,name,attibutes 

# Note, that the index counts from 1, and that the name 

# must be less than 12 characters long. 

# The attribute can be omitted; a value of 1 specifies the 

# port to be a system port. 

# --------------------------------------------------------- 

# This system has 32 analog IPs, 32 analog 

# outputs, 32 digital IPs, 32 digital OPs and no MADI. 

# Digital Inputs 1&2 are named DAT L&R respectively 

# Analog Outputs 25&26 are named Main Mon L&R respectively 

IO_CONFIG,1,32,32 

IO_CONFIG,2,32,32 

IO_CONFIG,3,0,0 

INPUT,2,1,DAT L 

INPUT,2,2,DAT R 

OUTPUT,1,25,Main Mon L,1 

OUTPUT,1,26,Main Mon R,1 

The Monitor_Matrix.TXT File 
The monitor matrix file is a text file which contains a complete set of upmix and 
downmix matrix coefficients. These are used when monitoring a larger format bus on 
a smaller format speaker set, or when selecting a larger or smaller monitoring format 
than the current monitor source bus. 

Monitor Downmix Matrix Defaults 

The monitoring downmix matrix allows any source format to be monitored on any 
format speaker system. The elements of the source signal path are distributed or 
summed and attenuated as necessary to maintain the soundfield image in the target 
format. 

When monitoring a source format with less elements than the current monitor format, 
the elements in the source format that also appear in the monitoring format are 
passed through to their respective loudspeakers unmodified. For example, when 
monitoring a stereo bus through a 5.1 speaker system, the left and right bus elements 
appear in the left and right speakers and the centre and surround speakers are 
ignored. The exception to this where the source format contains a centre or centre 
surround element and the target format does not. In these cases the centre channel is 
distributed between left and right elements 

Bass Management 

The default monitor matrix eliminates the boom or LFE channel when downmixing to 
a format that does not include a boom channel. If it is desired to add the boom signal 
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into the front monitors this may be done by adding the appropriate entries to the 
monitor matrix file as described below. 

Editing the Monitor_Matrix File 

The monitor matrix data is contained in a readable text file on the Satellite-AV 
computer. The file specifies both downmix and upmix combinations. This file can be 
opened and edited to conform to your specific monitoring requirements.  

The file is laid out as a comma delimited table. Each downmix entry begins with a 
description prefixed with a # (e.g. #Stereo to Mono). Each subsequent row describes 
a node in the matrix and has the following elements: 

SET_NODE command, source format (e.g. Stereo), destination format (e.g. Mono), 
source element (e.g. Left), destination element (e.g. Centre), Gain in dB. 

For example, here is the entry for Stereo to Mono downmix: 

# Stereo to Mono 
SET_NODE,Stereo,Mono,Left,Centre,-3 
SET_NODE,Stereo,Mono,Right,Centre,-3 

Source elements that are not passed through to the destination do not appear in the 
downmix entry. 

Follow these steps to edit the monitor_matrix file: 

Step 1 Quit FMC by holding down the Shift key and pressing the Pause/Break key 
on the PC keyboard and typing Q then Y. 

Step 2 Use the trackball to double-click on the Start button on the task bar at the 
bottom left of the mixer screen. 

Step 3 Use the trackball to select Programs > Accessories > Notepad. Notepad is 
a basic text editor application. 

Step 4 In Notepad select Open from the File menu at the top of the screen. 
Navigate to the following file and click Open  
C:\Program Files\ Fairlight\FMC\Data\monitor_matrix.txt 

Step 5 Select File > Save As and type monitor_matrix.bak to save a back up 
copy, then File > Open C:\Program Files\ Fair-
light\FMC\Data\monitor_matrix.txt to re-open the original file for editing. 

Step 6 Use the arrow keys to scroll down the file to the entry you wish to modify. 
Edit the gain value at the end of a line or type a new line to add an element 
(e.g. Boom). 

Step 7 When you have finished making changes click File > Save, then File > Exit 
to save the file and exit Notepad. 

Step 8 Click on the DREAM II Start Icon on the desktop to restart FMC and the disk 
recorder. 

Your modified monitor matrix settings are now active. 

Removing Boom from a Monitor Downmix 

The following setting sends the boom channel from a 5.1. bus to left and right 
speakers of a stereo monitor set: 

# 5.1 to Stereo 
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SET_NODE,5.1,Stereo,Left,Left,0 

SET_NODE,5.1,Stereo,Right,Right,0 

SET_NODE,5.1,Stereo,Centre,Left,-3 

SET_NODE,5.1,Stereo,Centre,Right,-3 

SET_NODE,5.1,Stereo,S-left,Left,0 

SET_NODE,5.1,Stereo,S-Right,Right,0 

SET_NODE,5.1,Stereo,Boom,Left,-3 

SET_NODE,5.1,Stereo,Boom,Right,-3 

Remove the last two lines to eliminate the boom element from the monitors as shown 
below: 

# 5.1 to Stereo 

#SET_NODE,5.1,Stereo,Left,Left,0 

#SET_NODE,5.1,Stereo,Right,Right,0 

#SET_NODE,5.1,Stereo,Centre,Left,-3 

#SET_NODE,5.1,Stereo,Centre,Right,-3 

#SET_NODE,5.1,Stereo,S-left,Left,0 

#SET_NODE,5.1,Stereo,S-Right,Right,0 

The DPC_Pan File 
The DPC_Pan file contains a table of pan gain values that is applied by the surround 
panner. The file contains three pan tables: LR, LCR, and 7.1. The LR table contains 
two columns and is used when panning between two speakers left to right or front to 
back. The LCR table contains three columns and is used for panning across the front 
speakers in LCR, LCRS, LCRSS, 6.1 and 5.1 surround formats, and the surround 
speakers in 6.1. The 7.1 table contains five columns and is used for panning across 
the five front speakers in 7.1. 

Each column contains 101 values which represent the gain in dB x 100 +1000. This 
results in a resolution of 0.1dB. The default pan law is a quadrant sine law.  

The System_Variables File 
The System_Variables file contains user configured setup parameters plus 
automatically generated system variables. Only modify the parameters described 
below. The file is located at C:\Program Files\Fairlight\FMC\Data\System_Variables.txt. 
To edit the file open it in Windows notepad as described above. 

Setting the Automation Lock Window 

The timecode lock window specifies the number of consecutive contiguous timecode 
frames that the automation system must read from the disk recorder before entering 
automation record. This prevents the system from dropping out of WRITE mode 
when locking to an external video transport. 

Edit the following line in System_Variables.txt: 

TC_LOCK_WINDOW,10 
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Change the number at the end of the line to specify the number of frames. This 
number will also determine the amount of pre-roll required prior to performing an 
automation mix pass.  

Typical values are:  

TC_LOCK_WINDOW,1 for Vmotion. 

TC_LOCK_WINDOW,5 for Betacam. 

TC_LOCK_WINDOW,10 for U-matic. 

Setting the Automation Punch Preroll21 

The automation punch preroll sets the transport preroll time applied when using 
punch to enter automation record. Edit the following line to specify the preroll time in 
seconds. 

TC_PUNCH_PREROLL,5 

Setting Momentary Talkback Time Threshold21 

The Momentary Talkback Time Threshold defines the amount of time the talkback key 
must be held down to prevent the switch from latching. The default value is 500 
milliseconds. 

Edit the following line in System_Variables.txt. Change the numerical value at the end of 
the line to specify the time threshold in milliseconds: 

MOMENTARY_TB_TIME_THRESHOLD,500 

Enabling AFL and PFL Modes 

AFL and PFL solo modes require two of the available buses. Disable AFL and PFL to 
free these buses.  

Edit the following line in System_Variables.txt. Change the numerical value at the end of 
the line to 1 for enabled or 0 to disable: 

AFL_PFL_ENABLED,1 

Joystick Snap 

The joystick snap setting defines the minimum distance in pixels, between the joystick 
bracket and the pan target in the channel display, required to capture the current pan 
position with the joystick. To alter the value edit the following line: 

JOYSTICK_SNAP,2 

Metering Numeric Peak Level 

The numeric peak levels displayed on the mixer display bus meters have a variable 
threshold. The level at which these values are displayed can be set in the 
System_Variables.txt file. Edit the following line in the file: 

PEAK_DISPLAY_LIMIT,950 

The value is from 0 to 1000 in 0.1dB steps where 1000 = full scale level. In the 
example above the value of 950 will cause the numeric display to first be shown when 
the signal level reaches -5dB below full scale. 970 will set the threshold to -3dB, 990 
will set the threshold to -1dB, and so on. 
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Overload Display Time 

Signal levels exceeding 0dBFS on the main meters are indicated by a overload hold 
display where all segments of the meter are illuminated orange. To clear this display 
press the Meter Sets key. The over hold time can be set by editing the following line 
in the file, enter the hold time in ten millisecond increments: 

Overload_display_time,1000 

Overload Peak Hold 

The main meters can display digital overloads by holding the entire bar. The amount 
of time this display remain after the overload has passed can be set. Edit the following 
line to enter the hold time in milliseconds. 

Overload_display_time,1000 

GPIO Enable 

The GPIO port on the rear of the Satellite-AV must be enabled for use by a GPIO 
macro. Replace the 0 with 1 in the following line to enable GPIOs. 

GPIO_ENABLED,0 

Plug-Ins I/O 

The physical digital I/O used by the optional plug-ins system must be specified. The 
I/O must be a block of 16 or 32 starting at 1, 17 or 33. Edit the following lines to 
specify the first channel and the range of the I/O block. 

PLUGINS_IO_START,17 

PLUGINS_IO_RANGE,16 

Plug-in Name Display 

The name of the plug-in may be displayed in the channel display. Edit the following 
line to turn this feature on or off. 

SHOW_PLUGIN_NAME,1 

Remote Mic amps 
To configure the Satellite-AV to control a UP4 mic pre, add the following statement to 
the FMC.INI file: 

  

UP4,ip_address,x       

where ip_address is the address of the UP4 unit, and x is the number of the first 
analogue input that it connects to (Note, that it MUST be connected to 4 consecutive 
inputs). 

FMC.ini and Command Line Options26 
FMC is launched automatically when you start DREAM II. 

FMC offers a number of additional command line options as listed below. These 
options may be used in a batch file for special applications. All start up options can 
also be set in the FMC initialisation file located at C:\Program 
Files\Fairlight\FMC\FMC.ini which overides the commandline options. If necessary, use 
the Notepad editor to edit the file. Click on the Start menu and select 
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Programs>Accessories>Notepad and open the FMC.ini file. Note that the DREAM 
IIStart Setup page will overwrite the FMC.ini file. 

FMC.ini 

FMC Commandline Options  
  

Option Description 

-c Run MSAT on the same machine as FMC ignoring the -p setting. 

-g Run without graphics. 

-h Hi-res mode (1600 x 1200) otherwise runs 1280 x 1024. 

-l Lo-res mode (1024 x 768). 

-m Enable mix automation. 

-p<###.###.###.###> Specify the IP address for a network connected machine running 
MSAT for testing. 

-s<#> Specify mixer type, where # = 0 for satellite, 1 for station48, 2 
for Satellite-AV , 3 for station24. 

-u Disables “stop on wrong USB driver” message. FMC will still 
check the drivers, still report out of date drivers and will still say 
that it can't continue - but it will continue anyway. 

  

BLUE Utils Menu 
The BLUE Utils menu offers the Update Sys-File item for storage of system settings. 
System Files are stored in the C:\Program Files\Fairlight\FMC\Data\ directory. 

Step 1 Hold down the BLUE key and press the Utils key to enter the Utils menu.  

Step 2 Press the Update Sys-File soft key to store the system settings. This 
information is stored in the following files: 

Monitor_Sources.TXT - patching and formats of external monitor sources. 

Speaker_Sets.TXT - patching and formats of all speaker sets. 

Setup_Variables.TXT - Call Follow state and Satellite-AV brightness. 
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Chapter 28 -  Specif ications 

Audio I/O Configuration 
See SX-20 and SX-48 installation guides for details. 

Satellite-AV Wiring and Connection Details 
The following information contains all the wiring details necessary for specifying studio 
cabling installations. Connector sex described is the panel mount connector on the 
rear of the Satellite-AV. 

Meter USB  
Description: USB and DC Power connection for external meters. Note that Sidecars do 
not require DC power. Cable must be shielded and less than 3 meters in length. 

Connector: 5 Pin XLR Female     
XLR5 SIGNAL PAIR 

PIN 1 USB + 1 

PIN 2 0 VDC  

PIN 3 12 VDC  

PIN 4 0 VDC  

PIN 5 USB - 1 

SHELL SHIELD 1 

  

Talkback 
Description: Mic level input and line level output for studio talkback microphone. Mic 
input may be configured to carry +8VDC phantom power for electret and condenser 
microphones. 

Connector: D 9 Female   
9 Pin D Type 
Connector 

Signal Pair 

PIN 1 TB Out + 1 

PIN 2 TB Out GND/Shield 1 

PIN 3 TB In GND/Shield 2 

PIN 4 NC  

PIN 5 TB In + 2 

PIN 6 TB Out - 1 

PIN 7 NC  

PIN 8 NC  

PIN 9 TB In - 2 
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USB 
Description: Standard USB port. Cable must be shielded and less than 3 meters in 
length. 

Connector: USB Type A Female   
USB Type A 
Connector 

Signal 

PIN 1 +5VDC 

PIN 2 USBDO- 

PIN 3 USBDO+ 

PIN 4 GND 

  

GPIO 
Description: General Purpose I/O 

Connector: D 15 Female 

Input:low < 0.8 volts 
high > 3.5volts < 5 volts 
Input voltages higher than 5 volts may cause damage to internal circuitry. 

Output:low < 0.8 volts  
high >= 3.5 volts   
15 Pin D Type 

Connector 
Signal 15 Pin D Type 

Connector 
Signal 

PIN 1 GP In 1 PIN 9 GND 

PIN 2 GP In 2 PIN 10 GND 

PIN 3 GP In 3 PIN 11 GND 

PIN 4 GP In 4 PIN 12 GND 

PIN 5 GP Out 1 PIN 13 GND 

PIN 6 GP Out 2 PIN 14 GND 

PIN 7 GP Out 3 PIN 15 GND 

PIN 8 GP Out 4   
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Ethernet23 
Description: 100BaseT ethernet interface to Satellite-AV or network. Use CAT5 
shielded twisted pair cable and shielded RJ45 connectors. 

Connector: RJ45 
  
PIN 1 Rx 

+ 

PIN 2 Rx - 

PIN 3 Tx 
+ 

PIN 6 Tx - 

  

Cross-over Cable 

Required for direct connection between Satellite-AV and engine. Not required if hub is 
present. 
  
RJ45-1 Signal RJ45-2 

PIN 1 Rx + PIN 3 

PIN 2 Rx - PIN 6 

PIN 3 Tx + PIN 1 

PIN 6 Tx - PIN 2 
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